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•	 Macintosh, Mac OS X and PowerBook are trademarks of Apple Inc. registered in the U.S. and other countries.

•	 Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered 
trademark or trademark of Microsoft Corporation in the United States and/or other countries.

•	 MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.

•	 Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.

•	 HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI 
Licensing LLC.

•	 Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other 
countries and areas.

•	 Wi-Fi®, Wi-Fi Alliance®, and Wi-Fi Protected Access (WPA, WPA2)® are registered trademarks of the Wi-Fi Alli-
ance.

•	 Blu-ray is a trademark of Blu-ray Disc Association

•	 Other product and company names mentioned in this user’s manual may be the trademarks or registered trademarks 
of their respective holders.

•	 GPL/LGPL Software Licenses

	 The product includes software licensed under GNU General Public License (GPL), GNU Lesser General Public 
License (LGPL), and others.

	 For more information on each software, see “readme.pdf” inside the “about GPL&LGPL” folder on the supplied CD-
ROM.

NOTES
(1)	The contents of this user’s manual may not be reprinted in part or whole without permission.

(2)	The contents of this user’s manual are subject to change without notice.

(3)	Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable 
points, errors or omissions, please contact us.

(4)	Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed 
to result from using the Projector.
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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily 
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical 
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this 
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regula-
tions.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

CAUTION
Avoid displaying stationary images for a prolonged period of time.

Doing so can result in these images being temporarily sustained on the surface of the LCD panel.

If this should happen, continue to use your projector. The static background from previous images will 
disappear.

Disposing of your used product
EU-wide legislation as implemented in each Member State requires that used electrical and electronic 
products carrying the mark (left) must be disposed of separately from normal household waste. This in-
cludes projectors and their electrical accessories or lamps. When you dispose of such products, please 
follow the guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us 
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human 
health and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member 
States.
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California 
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those 
specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regu-
lation could void your right to operate this equipment. This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

•	Reorient or relocate the receiving antenna.

•	Increase the separation between the equipment and receiver.

•	Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

•	Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with 
this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them 
carefully and heed all warnings.

Installation

• Do not place the projector in the following conditions:

-	on an unstable cart, stand, or table.

-	near water, baths, or damp rooms.

-	in direct sunlight, near heaters, or heat radiating appliances.

-	in a dusty, smoky or steamy environment. 

-	on a sheet of paper or cloth, rugs or carpets.

• If you wish to have the projector installed on the ceiling:

-	Do not attempt to install the projector yourself.

-	The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.

-	In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes.

-	Please consult your dealer for more information.
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 Fire and Shock Precautions 

•	 Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your 
projector. Allow at least 4 inches (10cm) of space between your projector and a wall.

•	 Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while 
the projector is turned on and immediately after the projector is turned off. Parts of the projector may become tem-
porarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during 
normal projector operation. 

	 Use caution when picking up the projector.

	

•	 Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve 
any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your 
projector. If something should fall into your projector, disconnect it immediately and have the object removed by a 
qualified service personnel.

•	 Do not place any objects on top of the projector.
•	 Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
•	 The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply 

fits this requirement before attempting to use your projector.
•	 Do not look into the lens while the projector is on. Serious damage to your eyes could result.

	

WARNING
•	Do not use any other object than the projector’s sliding lens cover to cover the lens while the projector is on. 

	 Doing so can cause the object to get extremely hot, and possibly resulting in a fire or damage due to the heat 
emitted from the light output.

•	Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of 
the cap due to the heat emitted from the light output.

•	Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead 
to the object melting from the heat that is emitted from the light output.

Place the projector in a horizontal position
The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other 
than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

10°
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•	 Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the 
lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause 
an unpredictable outcome such as a fire or injury to the eyes.

•	 Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent.
	 Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the ex-

haust.
•	 Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.

-	 Do not use any power cord other than the one supplied with the projector.
-	 Do not bend or tug the power cord excessively.
-	 Do not place the power cord under the projector, or any heavy object.
-	 Do not cover the power cord with other soft materials such as rugs.
-	 Do not heat the power cord.
-	 Do not handle the power plug with wet hands.

•	 Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under 
the following conditions:
-	 When the power cord or plug is damaged or frayed.
-	 If liquid has been spilled into the projector, or if it has been exposed to rain or water. 
-	 If the projector does not operate normally when you follow the instructions described in this user’s manual.
-	 If the projector has been dropped or the cabinet has been damaged.
-	 If the projector exhibits a distinct change in performance, indicating a need for service.

•	 Disconnect the power cord and any other cables before carrying the projector.
•	 Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
•	 Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
•	 When using a LAN cable (only models with the RJ-45 LAN port):
	 For safety, do not connect to the connector for peripheral device wiring that might have excessive voltage.

 CAUTION
•	 Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hang-

ing on the wall can cause damage to the projector.

•	 Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the 
soft case could be damaged.

•	 Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select 
[SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)

•	 Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while 
the projector is turned on and immediately after the projector is turned off.

•	 Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blink-
ing blue. Doing so could cause premature lamp failure.

Remote Control Precautions
•	 Handle the remote control carefully.

•	 If the remote control gets wet, wipe it dry immediately.

•	 Avoid excessive heat and humidity.

•	 Do not short, heat, or take apart batteries.

•	 Do not throw batteries into fire.

•	 If you will not be using the remote control for a long time, remove the batteries.

•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.

•	 Do not use new and old batteries together, or use different types of batteries together.

•	 Dispose of used batteries according to your local regulations.
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Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
•	 Use the specified lamp for safety and performance.

•	 To replace the lamp, follow all instructions provided on page 120.

•	 Be sure to replace the lamp and filter when the message [THE LAMP HAS REACHED THE END OF ITS USABLE 
LIFE. PLEASE REPLACE THE LAMP AND FILTER.] appears. If you continue to use the lamp after the lamp has 
reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp 
case. Do not touch them as the pieces of glass may cause injury.

	 If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on 
and off will increase the possibility of its lower brightness.

 CAUTION:

•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off 
and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

•	 When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass 
fragments could fall if the lamp has been burned out.

About High Altitude mode
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or 

higher.
	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] 

can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and 
turn on the projector.

•	 Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] 
can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

•	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical com-
ponents such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue 
such as a coffee shop or hotel and employing compression or expansion of the screen image with the following func-
tions may raise concern about the infringement of copyrights which are protected by copyright law.
[ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflec-
tions at visual display workplaces this device must not be placed in the direct field of view.
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Projector

[M350XS/M300XS/M260XS/M300WS/
M260WS]

[M420X/M420XV]

1. Introduction
1 What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

Power cord
US
(7N080236: M300X/M260X/M300W/M260W)
(7N080240: M300XS/M300WS)
EU
(7N080022: M350X/M300X/M260X/M230X/
M300W/M260W/M420X/M420XV)
(7N080026: M350XS/M300XS/M260XS/
M300WS/M260WS)

Computer cable (VGA)
(7N520073)

NEC Projector CD-ROM
User’s manual (PDF) and the util-
ity software
(7N951543)

For North America only
Registration card
Limited warranty

For customers in Europe: 
You will find our current valid Guarantee Policy on our Web Site: 
www.nec-display-solutions.com

The M420X/M420XV and 
M350XS/M300XS/M260XS/
M300WS/M260WS  do not come 
with a soft case.

•	 Important Infomation (For North 
America: 7N8N1181) (For Other 
countries than North America: 
7N8N1181 and 7N8N1192)

•	 Quick Setup Guide (For North Amer-
ica: 7N8N1201) (For Other countries 
than North America: 7N8N1201 and 
7N8N1211)

Remote control
(7N900922)

Batteries (AAA × 2)

Unless otherwise described in the user’s manual, the drawings for the projector cabinet show examples of the M350X.

Soft case
(24BS8121)[M350X/M300X/M260X/M230X/M300W/M260W]
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 Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector
This projector is one of the very best projectors available today. The projector enables you to project precise images up 
to 300 inches (110 inches on short-throw models) across (measured diagonally) from your PC or Macintosh computer 
(desktop or notebook), VCR, DVD player, or document camera.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, 
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1	 Do not attempt to mount the projector on a ceiling yourself.

	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.

	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes. Please consult your dealer for more information.

 
Features you’ll enjoy:

•	 Quick start (3 seconds*1), Quick Power Off (0 seconds), Direct Power Off

	 3 seconds*1 after turning on the power, the projector is ready to display PC or video images.

	 The projector can be put away immediately after the projector is powered down. No cool down period is required 
after the projector is turned off from the remote control or cabinet control panel.

	 The projector has a feature called “Direct Power Off”. This feature allows the projector to be turned off (even when 
projecting an image) by using the Main Power Switch or disconnecting the AC power supply.

	 To turn off the AC power supply when the projector is powered on, use a power strip equipped with a switch and 
a breaker.

	 *1 The quick start time is only when [STANDBY MODE] is set to [NORMAL] in the on-screen message.

•	 0.2 W (100-130 V AC)/0.4 W (200-240 V AC) in standby condition with energy saving technology

	 Selecting [POWER-SAVING] for [STANDBY MODE] from the menu can put the projector in power-saving mode 
that consumes only 0.2 W (100-130 V AC)/0.4 W (200-240 V AC).

•	 Carbon Meter 

	 This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO 
MODE] is set to [AUTO ECO], [ECO1], or [ECO2]*2.

	 The amount of CO2 emission reduction will be displayed in the confirmation message at the time of power-off and 
in the INFO of the on-screen menu.

	 *2 [ECO2] is available on M300X, M260X, and M260XS only.

•	 Longer lamp life without cleaning the filters regularly 

	 Using in Eco Mode allows you to prolong the projector’s lamp life. 

	 The two-layer, large filters require no regular cleaning. Filter replacement is requred only at the time of the lamp 
replacement.

•	 Short throw distances (M350XS/M300XS/M260XS/M300WS/M260WS)

	 Short focal lenses provide for a larger image using a shorter throw distance when compared to a typical projector 
lens.

•	 HDMI input port provides digital signal 

	 The HDMI input provides HDCP compatible digital signals. The HDMI input also supports audio signal.

•	 10 W built-in speaker for an integrated audio solution (not available on M420XV)

	 Powerful 10 watt monaural speaker provides volume need for large rooms.
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•	 The supplied remote control allows you to assign a CONTROL ID to the projector

	 Multiple projectors can be operated separately and independently with the same single remote control by assigning 
an ID number to each projector.

•	 Auto vertical keystone correction

	 Auto Keystone feature allows the projector to detect its tilt and correct vertical distortion automatically.

•	 USB Display 

	 Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with 
the projector allows you to send your computer screen image to the projector without the need of a traditional 
computer cable (VGA).

•	 Integrated RJ-45 connector for wired networking capability along with wireless networking capabilities

	 An RJ-45 connector is standard. An optional USB Wireless LAN Unit is required for wireless LAN connection.

•	 Software programs (User Supportware) contained in the supplied CD-ROM

	 The supplied NEC Projector includes four programs: Virtual Remote Tool, Image Express Utility Lite, PC Control 
Utility Pro 4, and Viewer PPT Converter 3.0. 

•	 AUTO POWER ON and AUTO POWER OFF features

	 The AUTO POWER ON(AC), AUTO POWER ON(COMP1), AUTO POWER OFF, and OFF TIMER features eliminate 
the need to always use the POWER button on the remote control or projector cabinet.

•	 Preventing unauthorized use of the projector

	 Enhanced smart security settings for keyword protection, cabinet control panel lock, security slot, and security 
chain opening to help prevent unauthorized access, adjustments and theft deterrence.

•	 High resolution up to UXGA

	 High resolution display - up to UXGA compatible, XGA (M350X/M300X/M260X/M230X/M420X/M420XV/M350XS/
M300XS/M260XS)/WXGA (M300W/M260W/M300WS/M260WS) native resolution.

About this user’s manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to 
review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find 
an overview. If the section doesn’t apply, you can skip it.
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Comparative Table of Main Features
The main features vary depending on the model as follows.

Standard Models
Standard Models 
with Wide Panel

Short-Throw Models
Short-Throw 

Models with Wide 
Panel

M350X M300X M260X M230X M420X M420XV M300W M260W M350XS M300XS M260XS M300WS M260WS
Native Aspect 
Ratio 4:3

Standard

16:10
Wide

4:3
Standard

16:10
Wide

Native Resolu-
tion (dots × 
lines*1) 

XGA (1024 × 768)
WXGA (1280 × 

800)
XGA (1024 × 768)

WXGA (1280 × 
800)

Screen Size 25" - 300" 60" - 110"
Throw Distance

26–543 inches/0.65–13.8 m
25–542 inch-
es/0.6–13.8 m

27–573 inch-
es/0.69–14.6 m

18-43 inches/0.5-1.1 m

Light output*2*3 
in OFF for ECO 
MODE 

3500 
lumens

3000 
lumens

2600 
lumens

2300 
lumens

4200 lumens
3000 

lumens
2600 

lumens
3500 

lumens
3000 

lumens
2600 

lumens
3000 

lumens
2600 

lumens

Lamp Replace-
ment Time 
(average) 

OFF for ECO MODE/ON for ECO MODE (H)
4000/ 
5000

5000/6000 3000/3500
4000/ 
5000

5000/ 
6000 

3000/ 
3500

4000/ 
5000

5000/ 
6000

3000/ 
3500

4000/ 
5000

Lamp Model NP16LP NP15LP NP17LP NP16LP NP15LP NP17LP NP16LP NP15LP NP17LP NP16LP
Lamp Wattage 
(AC)

230 W 180 W 265 W 230 W 180 W 265 W 230 W 180 W 265 W 230 W

Zoom 
Using the manual zoom lever

Using the [DIGITAL ZOOM] function from the 
menu

Focus Using the manual focus ring Using the manual focus lever

For further details on the specifications, see pages 130 to 135.

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is 

selected as the [PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

TIP: The model name is located on the cabinet.

Model name
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 Part Names of the Projector
Front/Top
[M350X/M300X/M260X/M230X/M300W/M260W]

[M420X/M420XV]

[M350XS/M300XS/M260XS/M300WS/M260WS]

Controls
(→ page 8)

Controls
(→ page 8)

Lens

Lens

Remote Sensor
(→ page 11)

Remote Sensor
(→ page 11)

Ventilation (inlet) / Filter Cover
(→ page 115, 123)

Ventilation (inlet) / Filter Cover
(→ page 117, 125)

Zoom Lever (→ page 21)

Zoom Lever (→ page 21)

Lens Cover

Lens Cover

Focus Ring
(→ page 23)

Focus Ring
(→ page 23)

Adjustable Tilt Foot  
(→ page 20)

Adjustable Tilt Foot  
(→ page 20)

Adjustable Tilt Foot Lever  
(→ page 20)

Adjustable Tilt Foot Lever  
(→ page 20)

Ventilation (outlet)
Heated air is exhausted from here.

Ventilation (outlet)
Heated air is exhausted from here.

Controls
(→ page 8)

Lens Cap

Ventilation (inlet) / Filter Cover
(→ page 117, 125)

Focus Lever
(→ page 23)

Remote Sensor
(→ page 11)

Lens

Adjustable Tilt Foot  
(→ page 20)

Adjustable Tilt Foot Lever  
(→ page 20)

Ventilation (outlet)
Heated air is exhausted from here.
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Rear
[M350X/M300X/M260X/M230X/M300W/M260W]

[M420X/M420XV]

AC Input
Connect the supplied power cord’s 

three-pin plug here, and plug the 
other end into an active wall outlet. 

(→ page 15)

Port Cover for Optional USB  
Wireless LAN Unit 

When using the optional USB 
Wireless LAN Unit, first remove 

the cover. (→ page 111)

Terminal Panel (→ page 9)

Monaural Speaker (10 W)

Lamp Cover (→ page 121)

Rear Foot (→ page 20)

Built-in Security Slot (  )* Security chain opening 
Attach an anti-theft device.
The security chain opening accepts 
security wires or chains up to 0.18 
inch/4.6 mm in diameter.

AC Input
Connect the supplied power cord’s 

three-pin plug here, and plug the 
other end into an active wall outlet. 

(→ page 15)

Connection for cable cover (Left/
right)

Screw holes temporarily fixing 
grooves for the optional cable cover 

(→ page 114)

Port Cover for Optional USB  
Wireless LAN Unit 

When using the optional USB 
Wireless LAN Unit, first remove 

the cover. (→ page 111)

Terminal Panel (→ page 9)

Monaural Speaker (10 W)
(The M420XV does not come with 

the speaker.)

Lamp Cover (→ page 121)

Rear Foot (→ page 20)

Security chain opening 
Attach an anti-theft device.
The security chain opening accepts 
security wires or chains up to 0.18 
inch/4.6 mm in diameter.

Built-in Security Slot (  )*

*	 This security slot supports the MicroSaver ® Security System.
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Opening and closing the lens cover
Slide the lens cover to the left to uncover the lens.

To cover the lens, slide the lens cover to the right.

NOTE:
•	 The lens cover works in conjunction with the AV mute function. Closing the lens cover will turn off the image and sound 

during normal projector operation; opening it will restore the image and sound.
	 With the lens cover closed the image and sound is turned off, however the lamp is still lit. If the projector stays this way for 

about 2 hours, it will turn off automatically.
•	 Do not pull the lens cover with excessive force or apply strong pressure in either the up or down direction. Doing so can 

cause damage to the lens cover sliding mechanism!

[M350X/M300X/M260X/M230X/M300W/M260W/M420X/M420XV]

[M350XS/M300XS/M260XS/M300WS/M260WS]

AC Input
Connect the supplied power cord’s 

three-pin plug here, and plug the 
other end into an active wall outlet. 

(→ page 15)

Connection for cable cover (Left/
right)

Screw holes temporarily fixing 
grooves for the optional cable cover 

(→ page 114)

Port Cover for Optional USB  
Wireless LAN Unit 

When using the optional USB 
Wireless LAN Unit, first remove 

the cover. (→ page 111)

Terminal Panel (→ page 9)

Monaural Speaker (10 W)

Lamp Cover (→ page 121)

Rear Foot (→ page 20)

Security chain opening 
Attach an anti-theft device.
The security chain opening accepts 
security wires or chains up to 0.18 
inch/4.6 mm in diameter.

Built-in Security Slot (  )*

*	 This security slot supports the MicroSaver ® Security System.
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Top Features

1/2

5

6

4

7

8 11

9

3

10

1.	  (POWER) Button (→ page 16, 27)

2.	 POWER Indicator (→ page 15, 16, 27, 127)

3.	 STATUS Indicator (→ page 127)

4.	 LAMP Indicator (→ page 120, 127)

5.	 ECO Button (→ page 30)

6.	 SOURCE Button (→ page 18)

7.	 AUTO ADJ. Button (→ page 26)

8.	 MENU Button (→ page 69)

9.	  / Volume Buttons  / Keystone Buttons 
 (→ page 24, 26)

10.	ENTER Button (→ page 69)

11.	EXIT Button (→ page 69)
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Terminal Panel Features

1235613 12

8711 14910

4

1.	 COMPUTER 1 IN/ Component Input Connector 
(Mini D-Sub 15 Pin) (→ page 104, 108)

2.	 COMPUTER 1 AUDIO IN Mini Jack (Stereo Mini)  
(→ page 104, 107, 108) (not available on M420XV)

3.	 COMPUTER 2 IN / Component Input Connector 
(Mini D-Sub 15 Pin) (→ page 104, 108)

4.	 COMPUTER 2 AUDIO IN Mini Jack (Stereo Mini)  
(→ page 104, 107, 108) (not available on M420XV)

5.	 HDMI IN Connector (Type A)  
(→ page 104, 109)

6.	 USB (PC) Port (Type B)  
(→ page 42, 104)

7.	 MONITOR OUT (COMP. 1) Connector (Mini D-Sub 
15 Pin) (→ page 106)

8.	 AUDIO OUT Mini Jack (Stereo Mini) (→ page 106)
	 (not available on M420XV)

9.	 S-VIDEO IN Connector (Mini DIN 4 Pin)
	 (→ page 107)

10.	VIDEO IN Connector (RCA) (→ page 107)

11.	VIDEO/S-VIDEO AUDIO IN L/MONO, R (RCA)  
(→ page 107) (not available on M420XV)

12.	LAN Port (RJ-45) (→ page 110)

13.	USB Port (Type A) (→ page 60)

14.	PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin)  
(→ page 141)

	 Use this port to connect a PC or control system. This 
enables you to control the projector using serial commu-
nication protocol. If you are writing your own program, 
typical PC control codes are on page 141.
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 Part Names of the Remote Control

3
7
5
6

1

2

10
15

16
14
17

9

4
8

13

29

30
31

19
20
25
27

28
24

18

23

22
21

26

32

12
11

1.	 Infrared Transmitter
	 (→ page 11)

2.	 POWER ON Button
	 (→ page 16)

3.	 POWER OFF Button
	 (→ page 27)

4, 5, 6. COMPUTER 1/2/3 Button
	 (→ page 18) 
	 (COMPUTER 3 button is not available.)

7.	 AUTO ADJ. Button
	 (→ page 26)

8.	 VIDEO Button
	 (→ page 18)

9.	 S-VIDEO Button
	 (→ page 18)

10.	HDMI Button (→ page 18)

11.	VIEWER Button (→ page 18, 60)

12.	NETWORK Button (→ page 18)

13.	USB DISPLAY Button (→ page 18)

14.	ID SET Button
	 (→ page 86)

15.	Numeric Keypad Button/CLEAR Button
	 (→ page 86)

16.	FREEZE Button
	 (→ page 29)

17.	AV-MUTE Button
	 (→ page 29)

18.	MENU Button
	 (→ page 69)

19.	EXIT Button (→ page 69)

20.	 Button (→ page 69)

21.	ENTER Button (→ page 69)

22.	D-ZOOM (+)(–) Button
	 (→ page 29)

23.	MOUSE L-CLICK Button*
	 (→ page 41)

24.	MOUSE R-CLICK Button*
	 (→ page 41)

25.	PAGE / Button*
	 (→ page 41)

26.	ECO Button (→ page 30)

27.	KEYSTONE Button
	 (→ page 25)

28.	PICTURE Button
	 (→ page 74, 76)

29.	VOL. (+)(–) Button
	 (→ page 26)

30.	ASPECT Button
	 (→ page 79)

31.	FOCUS/ZOOM Button
	 The ZOOM button works on the short-throw models 

only. The FOCUS button does not work on this series 
of projectors.

32.	HELP Button
	 (→ page 94)

*	 The PAGE /, , MOUSE L-CLICK and MOUSE R-CLICK buttons work only when a USB cable is connected 
with your computer..
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Remote Control Precautions
•	 Handle the remote control carefully.
•	 If the remote control gets wet, wipe it dry immediately.
•	 Avoid excessive heat and humidity.
•	 Do not short, heat, or take apart batteries.
•	 Do not throw batteries into fire.
•	 If you will not be using the remote control for a long time, remove the batteries.
•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.
•	 Do not use new and old batteries together, or use different types of batteries together.
• 	 Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

1 Press firmly and slide the battery 
cover off.

2 Install new batteries (AAA). Ensure 
that you have the batteries’ polarity 
(+/−) aligned correctly.

•	 The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of 
the remote sensor on the projector cabinet.

•	 The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls 
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

Battery Installation

3 Slip the cover back over the bat-
teries until it snaps into place. Do 
not mix different types of batteries 
or new and old batteries.

30°

30°

30°

30°

OP
EN

7 m/22 feet

7 m/22 feet

Remote control

Remote sensor on projector cabinet

OP
EN

Remote control

TIP:
Short-throw model (M350XS/M300XS/
M260XS/M300WS/M260WS):
The front remote sensor is located on the 
front left of the cabinet.
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 Operating Environment for Software Included on CD-ROM
Names and Features of Bundled Software Programs

Name of software program Features

Virtual Remote Tool This is a software program used to control the power ON/OFF and source selec-
tion of the projector from your computer by using the supplied computer cable 
(VGA) and it is also used to send an image to the projector and register it as the 
logo data of the projector. After registering it, you can lock the logo to prevent it 
from changing. (→ page 35)

Name of software program Features

Image Express Utility Lite •	 This is a software program used to project your computer’s screen over the 
USB cable or the wired/wireless network. The computer cable (VGA) is not 
required. (→ page 42, page 53)

•	 This software program can be used to control the power ON/OFF and source 
selection of the projector from your computer.

•	 The Geometric Correction Tool (GCT) function allows you to correct distortion 
of images projected on a curved wall. (→ page 56) 

Name of software program Features

PC Control Utility Pro 4 This is a software program used to operate the projector from the computer when 
the computer and the projector are connected with LAN (wired or wireless) or 
a serial cable. (→ page 50)

Name of software program Features

Viewer PPT Converter 3.0 This is a software program used to convert files created with PowerPoint into 
JPEG files that can be displayed with the viewer function of the projector when 
a USB memory device is inserted into the projector. (→ page 66)

NOTE:
•	 Image Express Utility Lite does not support “Meeting Mode” in Image Express Utility 2.0 included with our other models.

Download service
For the update information about these software programs, visit our website:
URL: http://www.nec-display.com/dl/en/index.html
 

http://www.nec-display.com/dl/en/index.html
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Operating Environment
The following is the operating environment for Image Express Utility Lite. For the operating environment of other soft-
ware program, refer to the help function of each software program.

Supported OS Windows 7 Home Basic
Windows 7 Home Premium
Windows 7 Professional
Windows 7 Ultimate
Windows 7 Enterprise
Windows Vista Home Basic
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise
Windows XP Home Edition Service Pack 3 or later
Windows XP Professional Service Pack 3 or later
•	 Only 32-bit version
•	 Windows power-saving function is not supported.

Processor •	 Windows 7/Windows Vista
Pentium M 1.2 GHz equivalent or higher required
Dual core 1.5 GHz or higher recommended

•	 Windows XP
Pentium M 1.0 GHz equivalent or higher required
Dual core 1.0 GHz or higher recommended

Memory •	 Windows 7/Windows Vista
512 MB or more required
1 GB or more recommended

•	 Windows XP
256 MB or more required
512 MB or more recommended
* More memory may be required to run additional applications simultane-
ously.

Graphic processor •	 Windows 7/Windows Vista
The “Graphics” score 3.0 or more of “Windows Experience Index” recom-
mended.

Network environment TCP/IP-compatible wired LAN or wireless LAN
(* Use a wireless LAN unit complying with the Wi-Fi standard.)

Resolution •	 Windows 7/Windows Vista 
SVGA (800 × 600) or higher required
XGA (1024 × 768) recommended 

•	 Windows XP 
VGA (640 × 480) or higher required
XGA (1024 × 768) recommended

1024 dots × 768 lines - 1280 dots × 800 lines recommended (M300W/M260W/
M300WS/M260WS)

Screen Colors High Color (15 bits, 16 bits)
True Color (24 bits, 32 bits) (recommended)
•	 256 or fewer colors are not supported.
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This section describes how to turn on the projector and to project a picture onto the screen.

 Flow of Projecting an Image

Step 1
•	 Connecting your computer / Connecting the power cord (→ page 15)

	

Step 2 
•	 Turning on the projector (→ page 16)

	

Step 3 
•	 Selecting a source (→ page 18)

	

Step 4
•	 Adjusting the picture size and position (→ page 19)

•	 Correcting keystone distortion [KEYSTONE] (→ page 24)

	

Step 5
•	 Adjusting a picture and sound

-	 Optimizing a computer signal automatically (→ page 26)

-	 Turning up or down volume (→ page 26)

	

Step 6
•	 Making a presentation

	

Step 7
•	 Turning off the projector (→ page 27)

	

Step 8
•	 After use (→ page 28)

2. Projecting an Image (Basic Operation)
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2. Projecting an Image (Basic Operation)

 Connecting Your Computer/Connecting the Power Cord

1.	 Connect your computer to the projector.

	 This section will show you a basic connection to a computer. For information about other connections, see “6. 
Installation and Connections” on page 104.

	 Connect the computer cable (VGA) between the projector’s COMPUTER 1 IN connector and the computer’s port 
(mini D-Sub 15 Pin). Turn two thumb screws of both connectors to fix the computer cable (VGA).

2.	 Connect the supplied power cord to the projector.

	 First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other 
plug of the supplied power cord in the wall outlet.

	 The projector’s power indicator will flash for a few seconds and then will light orange* (standby mode).

	 The STATUS indicator will also light green*.

	 * �This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator 
section.(→ page 127) 

COMPUTER 1 IN

Make sure that the prongs are fully inserted into 
both the AC IN and the wall outlet.

To wall outlet ←

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.



16

2. Projecting an Image (Basic Operation)

Standby Blinking Power On

Steady orange light Blinking blue light Steady blue light

 Turning on the Projector

1.	 Uncover the lens by sliding the lens cover (M350X/
M300X/M260X/M230X/M300W/M260W/M420X/M420XV) 
or removing the lens cap (M350XS/M300XS/M260XS/
M300WS/M260WS)

	 [M350XS/M300XS/M260XS/M300WS/M260WS]

•	 Do not remove the lens cap by pulling on the string. 
Doing so can cause mechanical damage to the part 
around the lens.

2.	 Press the  (POWER) button on the projector cabinet 
or the POWER ON button on the remote control. 

	 The POWER indicator will turn to blue and the projector 
will become ready to use.

TIP: 
•	 When the message “Projector is locked! Enter your password.” 

is displayed, it means that the [SECURITY] feature is turned on. 
(→ page 32)

	 After you turn on your projector, ensure that the computer 
or video source is turned on and that the lens cover is 
open.

NOTE: When no input signal is present, the no-signal guidance is 
displayed (factory menu setting).

(→ page 127)

Lens cover

Lens cap
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2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one 
of the 27 menu languages.

To select a menu language, follow these steps:

1.	 Use the , H, F or E button to select one of the 27 
languages from the menu.

2.	 Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu 
operation.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 71 and 83)

NOTE: 
•	 When turning off the power supply and then back on by using a power strip or breaker.
	 Allow a minimum of 1 second between turning off the main power supply and turning it back on again.
	 Failing to do so could result in no power to the projector. (There will be no stand-by LED) 
	 Should this happen, unplug the power cord and plug it in again. Turn on the main power.
•	 If one of the following things happens, the projector will not turn on.
•	 If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the 

projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool 
down.

•	 When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
•	 If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. 

Cancel the lock by turning it off. (→ page 85)
•	 If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn on 

the power.
•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
•	 Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is 

stabilized.
•	 When the projector is turned on, it may take some time before the lamp light becomes bright.
•	 If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without display-

ing an image for some time and then the projector will display the image.
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 Selecting a Source
Selecting the computer or video source
NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button once. The projector will search for the available 
input source and display it. The input source will change as follows: 

COMPUTER1 → COMPUTER2 → HDMI → VIDEO → S-VIDEO → 
VIEWER → USB DISPLAY → COMPUTER1 → ...

•	 With the SOURCE screen displayed, you can press the SOURCE 
button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMPUTER1, COMPUTER2, HDMI, VIDEO, S-
VIDEO, VIEWER, NETWORK, or USB DISPLAY buttons.

Selecting Default Source 
You can set a source as the default source so that it will be displayed 
each time the projector is turned on.

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the  button twice to select [SETUP] and press the H but-
ton or the ENTER button to select [GENERAL].

3.	 Press the  button three times to select [OPTIONS(2)].

4.	 Press the H button six times to select [DEFAULT SOURCE SE-
LECT] and press the ENTER button.

	 The [DEFAULT SOURCE SELECT] screen will be displayed.

	 (→ page 90)

5.	 Select a source as the default source, and press the ENTER but-
ton.

6.	 Press the EXIT button a few times to close the menu.

7.	 Restart the projector.

	 The source you selected in step 5 will be projected.

NOTE: Even when [AUTO] is turned on, the [NETWORK] will not be automatically 
selected. To set your network as the default source, select [NETWORK].

TIP: 
•	 When the projector is in Standby mode, applying a computer signal from a 

computer connected to the COMPUTER 1 IN input will power on the projector 
and simultaneously project the computer’s image.

	 ([AUTO POWER ON(COMP1)] → page 90)
•	 On Windows 7, a combination of the Windows and P keys allows you to set up 

external display easily and quickly.
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2. Projecting an Image (Basic Operation)

 Adjusting the Picture Size and Position
Use the adjustable tilt foot, the zoom function or the focus function to adjust the picture size and position.
In this chapter drawings and cables are omitted for clarity.

Adjusting the throw angle (the height of an image)
[Tilt foot] (→ page 20)

Adjusting the left and right tilt of an image
[Rear foot] (→ page 20)

Finely adjusting the size of an image
[Zoom function] (→ page 21)

Adjusting the focus
[Focus function] (→ page 23)

Adjusting the keystone correction [KEYSTONE]* (→ page 24)

Automatic Keystone Correction function is turned on at the time of shipment.
To perform keystone correction manually, see “6. Correcting Keystone Distortion Manually” on page 24.
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2. Projecting an Image (Basic Operation)

2

1

3

Adjustable Tilt FootAdjustable Tilt 
Foot Lever

Adjust the Tilt Foot
1. 	Lift the front edge of the projector.

 CAUTION:
Do not try to touch the ventilation outlet during Tilt Foot adjustment 
as it can become heated while the projector is turned on and after it 
is turned off.

2. 	Push up and hold the Adjustable Tilt Foot Lever on the front of 
the projector to extend the adjustable tilt foot.

3. 	Lower the front of the projector to the desired height.

4. 	Release the Adjustable Tilt Foot Lever to lock the Adjustable tilt 
foot.

	 The tilt foot can be extended up to 1.6 inch/40 mm.

	 There is approximately 10 degrees (up) of adjustment for the front of 
the projector.

	 Rotate the rear foot to the desired height in order to square the image 
on the projection surface.

 CAUTION:
•	 Do not use the tilt-foot for purposes other than originally intended.
	 Misuses such as using the tilt foot to carry or hang (from the wall or 

ceiling) the projector can cause damage to the projector.

For short-throw models (M350XS/M300XS/M260XS/M300WS/
M260WS)

Short-throw models have a round lens protruding from the front cabinet. 
While adjusting the tilt foot, pay attention not to touch the lens.

Lens

Adjusting the left and right tilt of an image [Rear foot]
•	 Rotate the rear foot.

	 The rear foot can be extended up to 0.5 inch/12 mm. Rotating the rear 
foot allows the projector to be placed horizontally.

NOTE:
•	 Do not extend the rear foot beyond its height limit (0.5 inch/12 mm). Doing so 

may cause the rear foot to come out of the projector. 
 

Rear foot
Up Down
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Zoom
[M350X/M300X/M260X/M230X/M300W/M260W/M420X/M420XV]
Use the ZOOM lever to adjust the image size on the screen.

[M350XS/M300XS/M260XS/M300WS/M260WS]
The image size can be adjusted electronically from the menu. To do so, follow the steps below.
Adjusting with the ZOOM button on the remote control
1.	 Press the ZOOM button. 

	 The DIGITAL ZOOM bar will be displayed.

2.	 Press the ◀ or ▶ button to adjust the image size. 

3.	 Press the EXIT button.

	 The DIGITAL ZOOM bar will be closed. 

Zoom Lever
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2. Projecting an Image (Basic Operation)

Adjusting from the menu
1.	 Press the MENU button. 

	 The menu will be displayed.

2.	 Press the ▶ button to select [SETUP] and press the ENTER button. 

	 The [GENERAL] tab will be highlighted.

3.	 Press the ▼ button. 

	 The [DIGITAL ZOOM] will be highlighted. 

4.	 Use the ◀ or ▶ button to adjust the image size. 

5.	 After completing adjustment, press the EXIT button four times. 

	 The menu will be closed. 
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2. Projecting an Image (Basic Operation)

Focus
[M350X/M300X/M260X/M230X/M300W/M260W/M420X/M420XV]
Use the FOCUS ring to obtain the best focus.

[M350XS/M300XS/M260XS/M300WS/M260WS]
Use the FOCUS lever to obtain the best focus 

Focus Ring

FOCUS lever



24

2. Projecting an Image (Basic Operation)

 Correcting Keystone Distortion Manually
If the screen is tilted vertically, keystone distortion becomes large. Automatic Keystone Correction (AUTO KEYSTONE) 
function is turned on at the time of shipment. To correct keystone distortion manually, proceed with the following steps 
to correct keystone distortion. 

 

NOTE: 
•	 The Keystone correction can cause an image to be slightly blurred because the correction is made electronically.
•	 The Keystone correction range can be made narrower, depending on a signal or its aspect ratio selection.
•	 You may not get the desired result from the Auto Keystone correction, depending on the position of the zoom lever. If this hap-

pens, perform the Keystone correction manually.

Adjusting with buttons on the cabinet
1.	 Press the  or  button with no menus displayed.

	 The keystone bar will be displayed.

      

2.	 Use the  or  to correct the keystone distortion.

	 The keystone bar will be closed after a period of time.

3.	 Press the ENTER button.

	 The keystone bar will be closed.

NOTE: 
•	 When the menu is displayed, the above operation is not available. When the menu is displayed, press the MENU button to close 

the menu and start the Keystone correction.
	 From the menu, select [SETUP] → [GENERAL] → [KEYSTONE]. The changes can be saved with [KEYSTONE SAVE]. (→ page 

81)
•	 Keystone control is not available with the  or  button when VIEWER is used.
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Adjusting with the remote control
1.	 Press the KEYSTONE button.

	 The Keystone bar will be displayed.

	

2.	 Use the   or  button to correct the keystone distortion.

	 Adjust so that the right and left sides are parallel.

	

3.	 Press the EXIT button.

	 The Keystone bar will be closed.
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 Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust
Optimizing a computer image automatically. (COMPUTER1/COMPUTER2)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
•	 If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] 

manually. (→ page 77, 78)

 Turning Up or Down Volume (not available on M420XV)
Sound level from the speaker can be adjusted.

TIP: When no menus appear, the  and  buttons on the projector cabinet work 
as a volume control. 

NOTE:
•	 Volume control is not available with the  or  button when an image is enlarged 

by using the D-ZOOM (+) button or when the menu is displayed.
•	 Volume control is not available with the  or  button when VIEWER is 

used.

TIP: The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, 
from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].

Increase volume

Decrease volume



27

2. Projecting an Image (Basic Operation)

 Turning off the Projector

To turn off the projector:
1.	 First, press the  (POWER) button on the projector 

cabinet or the POWER OFF button on the remote con-
trol. 

	 The [POWER OFF / ARE YOU SURE? / CARBON SAV-
INGS- SESSION 0.000[g-CO2]] message will appear.

2.	 Secondly, press the ENTER button or press the  
(POWER) or the POWER OFF button again.

	 The lamp will turn off and the projector will go into standby 
mode. When in standby mode, the POWER indicator will 
light orange and the STATUS indicator will light green when 
[NORMAL] is selected for [STANDBY MODE]. 

Power On

Steady blue light

Standby

Steady  
orange light

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.

NOTE:
•	 While the power indicator is blinking blue in short cycles, the power cannot be turned off.
•	 You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
•	 Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing 

the menu. Doing so can cause loss of adjustments and settings.



28

2. Projecting an Image (Basic Operation)

 After Use
Preparation: Make sure that the projector is turned off.

1.	 Unplug the power cord.

2.	 Disconnect any other cables.
•	 Remove the USB memory if it is inserted into the projector.

3.	 Retract adjustable tilt foot if extended.
•	 Do not touch the lens.

4.	 Slide the lens cover to the right to cover the lens.
Short-throw model (M350XS/M300XS/M260XS/M300WS/
M260WS)

①	Place each catch on the bottom of the lens cap into two grooves of 
the projector.

②	Push the top of the lens cap to cover the lens.

1

2

5.	 Put the projector and accessories in the supplied soft case.
	 Place the projector in the soft case with the lens facing upward as shown below. This is to prevent the lens from 

damage.

Insert the projector with the lens 
facing upward

NOTE: 
•	 When placing the projector in the soft case, retract the tilt foot and the rear feet. Failure to do so may case damage to the projec-

tor.
•	 The M420X, M420XV, M350XS, M300XS, M260XS, M300WS, and M260WS do not come with a soft case.

 CAUTION:
Use caution when putting the projector in the soft case immediately after the projector has been operating. The 
projector cabinet is hot.
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1 Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short 
period of time. Press again to restore the image and sound.

The projector's power-saving function will work 10 seconds after the im-
age is turned off.

As a result, the lamp power will be reduced.

NOTE:
•	 Even though the image is turned off, the menu still remains on the screen.
•	 Sound from the AUDIO OUT jack (Stereo mini) can be turned off.
•	 Even when the power-saving function works, the lamp power may be restored 

to its original level temporarily.
•	 To restore the image, even if you press the AV MUTE button immediately after 

the start of the power-saving function, the lamp brightness may not be restored 
to its original level.

2 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume 
motion.

NOTE: The image is frozen but the original video is still playing back.

 Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on 
the signal.

To do so:

1.	 Press the D-ZOOM (+) button to magnify the picture.

	 To move the magnified image, use the ,, or  button.

3. Convenient Features
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 Changing Eco Mode/Checking Energy-Saving Effect 
Using Eco Mode [ECO MODE]
The ECO MODE (ECO1 and ECO2) increases lamp life, while lowering power consumption and cutting down on CO2 
emissions. 
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [ECO1] and [ECO2] modes. 

[ECO MODE] Description Status of LAMP indicator

[OFF] This is the default setting (100% Brightness). Off

[AUTO ECO] Lamp power consumption will be changed between 
[OFF] and [ECO1] automatically according to picture 
level
NOTE: A bright gradation may be less visible depending on 
the image.

Steady 
Green light

[ECO1] Low lamp power consumption (approx. 75% Brightness 
on M350X/M300W/M420X/M420XV/M350XS/M300XS/
M300WS/M260WS and approx. 80% Brightness on 
M300X/M260X/M230X/M260W/M260XS).

[ECO2] (M300X, 
M260X, and 
M260XS only)

Lower lamp power consumption than [ECO1] mode (ap-
prox. 50% Brightness on M300X/M260X/M260XS)

To turn on the [ECO MODE], do the following: 
1.	 Press the ECO Button on the remote control to display [ECO MODE] screen.

2.	 Press the ECO button again to select a mode you wish. 

•	 Each time the ECO button is pressed, the choices will be changed:

	 OFF → AUTO ECO → ECO1 (→ ECO2) → OFF

•	 When the projector is in ECO mode, the LAMP indicator will light green.

TIP: 
•	 The leaf symbol at the bottom of the menu shows the current selection of ECO mode.

2.	 Press the  button.
	 The area of the magnified image will be moved

3.	 Press the D-ZOOM (−) button.

	 Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE: 
•	 The image will be enlarged or reduced at the center of the screen.
•	 Displaying the menu will cancel the current magnification.
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NOTE: 
•	 The [ECO MODE] can be changed by using the menu.
	 Select [SETUP] → [GENERAL] → [ECO MODE].
•	 The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] →[USAGE TIME].
•	 The projector is always in [ECO1]* for 90 seconds after the lamp is turned on and while the POWER indicator is blinking blue. 

The lamp condition will not be affected even when [ECO MODE] is changed.
•	 After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, [ECO MODE] will 

automatically switch to [ECO1]*. The projector will return to the [OFF] once a signal is accepted.
•	 If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [ECO1]* mode 

to protect the projector. When the projector is in [ECO1]* mode, the picture brightness decreases. When the projector comes 
back to normal temperature, the [ECO MODE] returns to [OFF] mode.

	 Thermometer symbol [  ] indicates the [ECO MODE] is automatically set to [ECO1]* mode because the internal temperature is 
too high.

	 * [ECO2] on M300X, M260X, and M260XS only

Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO MODE] 
is set to [AUTO ECO], [ECO1], or [ECO2]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON 
SAVINGS] message shows the total amount of CO2 emission reduction from the time of shipment up to now. You can 
check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 94)

The [CARBON SAVINGS-SESSION] message shows the amount of CO2 emission reduction between the time of 
changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-
SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:
•	 The formula as shown below is used to calculate the amount of CO2 emission reduction.
	 Amount of CO2 emission reduction = (Power consumption in OFF for ECO MODE − Power consumption in AUTO ECO/ECO1/ECO2 

for ECO MODE) × CO2 conversion factor.* When the image is turned off with the AV MUTE button or with the lens cover closed, 
the amount of CO2 emmission reduction will also increase.

	 * �Calculation for amount of CO2 emission reduction is based on an OECD publication “CO2 Emissions from Fuel Combustion, 2008 
Edition”.

•	 The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
•	 This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
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5 Preventing the Unauthorized Use of the Projector [SECURITY]
A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword 
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the pro-
jector cannot project an image. 
• The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the  button twice to select [SETUP] and press the  button or the ENTER button to select [GEN-
ERAL].

3.	 Press the  button to select [INSTALLATION].

4.	 Press the  button three times to select [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

5. 	Press the  button to select [ON] and press the ENTER button.

	 The [SECURITY KEYWORD] screen will be displayed.

6.	 Type in a combination of the four  buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

	 The [CONFIRM KEYWORD] screen will be displayed.
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7.	 Type in the same combination of  buttons and press the ENTER button.

	 The confirmation screen will be displayed.

8.	 Select [YES] and press the ENTER button.

	 The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1.	 Press the POWER button.

	 The projector will be turned on and display a message to the effect that the projector is locked.

2.	 Press the MENU button.

3.	 Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
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To disable the SECURITY function:

1.	 Press the MENU button.

	 The menu will be displayed.

2. 	Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

3.	 Select [OFF] and press the ENTER button.

	 The SECURITY KEYWORD screen will be displayed.

4.	 Type in your keyword and press the ENTER button.

	 When the correct keyword is entered, the SECURITY function will be disabled.

NOTE: If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request 
code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] 
is a request code.
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 Using the Computer Cable (VGA) to Operate the Pro-
jector (Virtual Remote Tool)
Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote 
screen (Remote Control Window or toolbar) can be displayed on your computer screen.
This will help you perform operations such as projector’s power on or off and signal selection via the computer cable 
(VGA), serial cable, or LAN connection. Only via serial or LAN connection it is also used to send an image to the 
projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from 
changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute*, Logo transfer to the projector, and remote 
control operation on your PC.
NOTE:
* Audio mute function is not available on M420XV.

Virtual Remote screen

Remote Control Window Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 40)

Step 1: Install Virtual Remote Tool on the computer. (→ page 36)
Step 2: Connect the projector to the computer. (→ page 38)
Step 3: Start Virtual Remote Tool. (→ page 39)

TIP:
•	 Virtual Remote Tool can be used with a LAN and a serial connection.
•	 For update information on Virtual Remote Tool, visit our website: 
	 http://www.nec-display.com/dl/en/index.html

http://www.nec-display.com/dl/en/index.html
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NOTE:
•	 When [COMPUTER 1] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well 

as your computer screen.
•	 Use the supplied computer cable (VGA) to connect the COMPUTER 1 IN connector directly with the monitor output connector of 

the computer to use Virtual Remote Tool.
	 Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.
	 VGA cable connector:
	 Pin Nos. 12 and 15 are required for DDC/CI.
•	 Virtual Remote Tool may not work depending on your computer’s specifications and version of graphic adapters or drivers.
•	 To run Virtual Remote Tool on Windows XP Home Edition and Windows XP Professional, “Microsoft .NET Framework Version 

2.0 or later” is required. The Microsoft .NET Framework Version 2.0 or later is available from Microsoft’s web page. Download 
and install the it on your computer. 

•	 Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
	 (Only via serial or LAN connection)

-	 File size: 64 KB or less 
-	 Image size (resolution): Horizontal 699 dots × vertical 499 dots or less
-	 Number of colors: 256 colors or less

•	 The logo data that is sent with Virtual Remote Tool will be displayed at the center of the screen. Its surrounding will be painted 
out in the same color as one for 1 dot at top left.

TIP:
•	 The projector’s COMPUTER 1 IN connector supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard 

interface for bidirectional communication between display/projector and computer.

Step 1: Install Virtual Remote Tool on the computer

NOTE:
•	 To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 7, Windows Vista and 

Windows XP). 
•	 Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be com-

pleted. 

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 the menu window will be displayed.

2	 Click “Install Virtual Remote Tool” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.
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TIP:

Uninstalling Virtual Remote Tool
Preparation:
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have 
“Administrator” privilege (Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 7/Windows Vista
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Click “Uninstall a program” under “Programs”

	 The “Programs and Features” window will be displayed.

3	 Select Virtual Remote Tool and click it.

4	 Click “Uninstall/Change” or “Uninstall”.

	 • When the “User Account Control” windows is displayed, click “Continue”.

	 Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Double-click “Add / Remove Programs”.

	 The Add / Remove Programs window will be displayed.

3	 Click Virtual Remote Tool from the list and then click “Remove”.

	 Follow the instructions on the screens to complete the uninstallation.

Step 2: Connect the projector to the computer
1	 Use the supplied computer cable (VGA) to connect the COMPUTER 1 IN connector of the projector directly 

with the monitor output connector of the computer.

2	 Connect the supplied power cord to the AC IN of the projector and the wall outlet.

	 The projector is in the standby condition.

COMPUTER 1 IN

TIP:
•	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.

AC Input

Supplied computer cable (VGA)

→ To wall outlet

Power cord (supplied)
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Step 3: Start Virtual Remote Tool

Start using the shortcut icon
•	 Double-click the shortcut icon  on the Windows Desktop.

Start from the Start menu
•	 Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] 

→ [Virtual Remote Tool].

	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

	 Follow the instructions on the screens

	 When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:
•	 When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer 

cable (VGA) or network (wired LAN/wireless LAN) connection.

TIP:
•	 The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
	 To do so, click to place a check mark for “  Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.



40

3. Convenient Features

Exiting Virtual Remote Tool
1	 Click the Virtual Remote Tool icon  on the Taskbar.

	 The pop-up menu will be displayed.

2	 Click “Exit”.

	 The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool
• Displaying the help file using the taskbar
1	 Click the Virtual Remote Tool icon  on the taskbar when Virtual Remote Tool is running.

	 The pop-up menu will be displayed.

2.	 Click “Help” → “Help...”.

	 The Help screen will be displayed.

• Displaying the help file using the Start Menu.
1.	 Click “Start”. “All programs” or “Programs”. “NEC Projector User Supportware”. “Virtual Remote Tool”. and 

then “Virtual Remote Tool Help” in this order.

	 The Help screen will be displayed.
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 Operating Your Computer’s Mouse Functions from the Projector’s 
Remote Control via the USB Cable (Remote Mouse Function)
The built-in remote mouse function enables you to operate your computer’s mouse functions from the supplied remote 
control when the projector is connected to a computer via a commercially available USB cable (compatible with USB 
2.0 specifications).
The Remote Mouse function works for the COMPUTER 1 or COMPUTER 2 input while the computer screen is dis-
played.
The Remote Mouse function will not work while you freeze or magnify an image.
-	 Using the USB cable to connect the projector and the computer will also start USB Display function.

USB (PC)

NOTE:
•	 A USB cable must support the USB 2.0 Specifications.
•	 The mouse function can be used with the following operating systems:
	 Windows 7, Windows XP, or Windows Vista
•	 In SP2 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
	 Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer 

Options tab].
•	 Wait at least 5 seconds after disconnecting the USB cable before reconnecting it and vice versa. The computer may not identify 

the USB cable if it is repeatedly connected and disconnected in rapid intervals.
NOTE:
•	 Connect the projector to the computer with a USB cable after starting the computer. Failure to so may fail to start the computer.

Operating your computer’s mouse from the remote control
You can operate your computer’s mouse from the remote control.

PAGE / Button	���������������������������scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint 
on your computer.

 Buttons	������������������������������moves the mouse cursor on your computer.
MOUSE L-CLICK/ENTER Button	������works as the mouse left button.
MOUSE R-CLICK Button	������������������works as the mouse right button.

NOTE:
•	 When you operate the computer using the  or  button with the menu displayed, both the menu and the mouse pointer 

will be affected. Close the menu and perform the mouse operation.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user 
documentation or online help supplied with your computer.

USB cable (not supplied)
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 Projecting Your Computer’s Screen Image from the Projector 
via the USB Cable (USB Display)
Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with the 
projector allows you to send your computer screen image to the projector for displaying. Power On/Off and source 
selection of the projector can be done from your computer without connecting a computer cable (VGA).

NOTE:
•	 To make USB DISPLAY available on Windows XP, the Windows user account must have “Administrator” privilege.
•	 USB Display uses functions of Image Express Utility Lite contained on NEC Projector CD-ROM (→ page 53).
	 Starting USB Display, however, will not install Image Express Utility Lite on your computer. This is because USB Display executes 

the projector's program only. 
•	 USB Display will not work in [POWER-SAVING] of [STANDBY MODE]. (→ page 89)

1.	 Start the computer.

2.	 Connect the projector’s power cord to the wall outlet and put the projector into standby condition.

•	 Open the projector’s lens cover.

3.	 Use the USB cable to connect the computer with the projector.

USB (PC)

	 The message “The projector is in standby mode. Connect it?” will be displayed on the computer screen.

•	 The control window of Image Express Utility Lite will be displayed on the top of the screen.

NOTE: Depending on the computer setting, the “AutoPlay” window may be displayed when the 
computer detects the connection to the projector. If this happens, click the “Start USB Display” 
window.

4.	 Click “Yes”.

	 The projector will turn on and the message “The projector is getting ready. Please wait.” will be displayed on the 
computer screen. This message will disappear in a few seconds.

USB cable (not supplied)

→ To wall outlet

Power cord (supplied)
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5.	 Operate the control window.

(1)  (Source)	����� Selects an input source of the projector. 
(2)  (Picture)	���� Turns on or off the AV-MUTE (Picture mute), FREEZE (Freeze a picture), and Geometric Correction Tool 

(GCT) functions.
(3)  (Sound)	����� Turns on or off AV-MUTE (Sound mute), play the sound and turns up or down the volume.

*	 The “Sound” function is not available on M420XV.
(4)  (Others)	����� Uses “Update”, “HTTP Server”*, “Settings” and “Information”.

*	 The HTTP Server cannot be selected when a USB cable is connected.

(5)  (Exit)	���������� Exit Image Express Utility Lite. You can also turn off the projector at the same time.
(6)  (Help)	����������� Displays the help of Image Express Utility Lite.

(1) (2) (3) (4) (5)(6)
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 Controlling the Projector by Using an HTTP Browser
Overview
The HTTP Server function provides settings and operations for:
1.	 Setting for wired/wireless network (NETWORK SETTINGS)

	 To use wireless LAN connection, the optional USB Wireless LAN Unit is required. (→ page 111)

	 To use wired/wireless LAN connection, connect the projector to the computer with a commercially available LAN 
cable. (→ page 110)

2.	 Setting Alert Mail (ALERT MAIL)

	 When the projector is connected to a wired/wireless network, lamp replace time or error messages will be sent via 
e-mail.

3.	 Operating the projector

	 Power on/off, selecting input, volume control and picture adjustments are possible.

4.	 Setting PJLink PASSWORD and AMX BEACON

This device uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting 
method will vary depending on the version of browser. Please refer to the help files and the other information provided 
in your software.

Two ways of access to the HTTP server function are available:
•	 Start the Web browser on the computer via the network connected to the projector and enter the following 

URL :

	 http://<the projector’s IP address> /index.html

•	 Use Image Express Utility Lite contained on the supplied NEC Projector CD-ROM.

TIP: The factory setting IP address is [DHCP ON].

NOTE: 
•	 To use the projector in a network, consult with your network administrator about network settings.
•	 The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your net-

work.
	 Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in 

rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projec-
tor.

•	 If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web 
browser (or clear the cache).

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 110)
Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the 
setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set 
will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be 
reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
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Handling of the Address for Operation via a Browser
Regarding the actual address that is entered for the address or entered to the URL column when operation of the pro-
jector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the 
projector has been registered to the domain name server by a network administrator, or the host name corresponding 
to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: �When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network 
setting by specifying 
  http://pj.nec.co.jp/index.html 
for the address or the entry column of the URL.

Example 2: �When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by 
specifying 
  http://192.168.73.1/index.html 
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
ON	������������������������� Power is switched on.
OFF	������������������������ Power is switched off.

VOLUME: This controls the volume of the projector.
	��������������������������� Increases the volume adjustment value.
	��������������������������� Decreases the volume adjustment value.

AV-MUTE: This controls the mute function of the projector.
PICTURE ON	���������� Mutes the video.
PICTURE OFF	��������� Cancels the video muting.
SOUND ON	������������ Mutes the audio.
SOUND OFF	����������� Cancels the audio muting.
ALL ON	������������������ Mutes each of the video, and audio functions.
ALL OFF	����������������� Cancels the muting of each of the video, and audio functions.

NOTE:
•	 The “SOUND OFF”, “SOUND ON” and “VOLUME” functions are not available on M420XV.
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PICTURE: Controls the video adjustment of the projector.
BRIGHTNESS 	���� Increases the brightness adjustment value.
BRIGHTNESS 	���� Decreases the brightness adjustment value.
CONTRAST 	�������� Increases the contrast adjustment value.
CONTRAST 	�������� Decreases the contrast adjustment value.
COLOR 	�������������� Increases the color adjustment value.
COLOR 	�������������� Decreases the color adjustment value.
HUE 	������������������� Increases the hue adjustment value.
HUE 	������������������� Decreases the hue adjustment value.
SHARPNESS 	����� Increases the sharpness adjustment value.
SHARPNESS 	����� Decreases the sharpness adjustment value.

•	 The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 
76)

SOURCE SELECT: This switches the input connector of the projector.
COMPUTER 1	�������� Switches to the COMPUTER 1 IN connector.
COMPUTER 2	�������� Switches to the COMPUTER 2 IN connector.
HDMI	��������������������� Switches to the HDMI IN connector.
VIDEO	�������������������� Switches to the VIDEO IN connector.
S-VIDEO	���������������� Switches to the S-VIDEO IN connector.
VIEWER	����������������� Switches to the data on the USB memory device.
NETWORK	������������� Switches to a LAN signal.
USB DISPLAY	�������� Switches to the USB Port (PC).

PROJECTOR STATUS: This displays the condition of the projector.
LAMP LIFE REMAINING	�����Displays the remaining life of the lamp as a percentage.
LAMP HOURS USED	�����������Displays how many hours the lamp has been used.
FILTER HOURS USED	���������Displays how many hours the filter has been used.
ERROR STATUS	������������������Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).



47

3. Convenient Features

NETWORK SETTINGS

• SETTINGS

WIRED or WIRELESS

SETTING Set for wired LAN or for wireless LAN.

APPLY Apply your settings to wired LAN or wireless LAN.

DHCP ON Automatically assign IP address, subnet mask, and gateway to the projector from your 
DHCP server.

DHCP OFF Set IP address, subnet mask, and gateway to the projector assigned by your network 
administrator.

IP ADDRESS Set your IP address of the network connected to the projector.

SUBNET MASK Set your subnet mask number of the network connected to the projector.

GATEWAY Set the default gateway of the network connected to the projector.

AUTO DNS ON DHCP server will automatically assign IP address of DNS server connected to the 
projector.

AUTO DNS OFF Set your IP address of DNS server connected to the projector.

Setting for WIRED LAN

ENABLE Turn on wired LAN connection

DISABLE Turn off wired LAN connection

Setting for WIRELESS LAN (with the optional USB Wireless LAN Unit equipped) 

EASY CONNECTION Execute a wireless LAN using EASY CONNECTION.

CHANNEL Select a channel. Available channels vary depending on the country and region. When 
you select [INFRASTRUCTURE], make sure that the projector and your access point 
are on the same channel; when you select [AD HOC], make sure that the projector and 
your computer are on the same channel.

PROFILE 1/PROFILE 2 Two settings can be set for wireless LAN connection. Select PROFILE 1 or PROFILE 
2.

SSID Enter an identifier (SSID) for wireless LAN. Communication can be done only with 
equipment whose SSID matches SSID for your wireless LAN.

SITE SURVEY Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you 
can access.
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NETWORK TYPE Select communication method when using wireless LAN.
INFRASTRUCTURE: Select this option when communicating with one or more equip-
ment connected to the wireless LAN network via a wireless access point.
AD HOC: Select this option when using the wireless LAN to directly communicate with 
a computer in peer-to-peer mode. 

SECURITY TYPE Turn on or off the encryption mode for secure transmission. When turn on the encryp-
tion mode, set WEP key or encrypted key.

DISABLE Will not turn on the encryption feature. Your communications 
may be monitored by someone.

WEP 64 bit Uses 64-bit datalength for secure transmission.

WEP 128 bit Uses 128-bit datalength for secure transmission. This option will 
increase privacy and security when compared to use of 64-bit 
datalength encryption.

WPA PSK-TKIP/
WPA PSK-AES/
WPA2 PSK-TKIP/
WPA2 PSK-AES

These options provide stronger security than WEP.

NOTE:
•	 The WEP settings must be the same as communication devices such as PC or access point in 

your wireless network.
•	 When you use WEP, your image transmission speed will slow down.
•	 [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] and [WPA2 PSK-AES] are not available 

when [AD HOC] is selected from [NETWORK TYPE].

INDEX Select encryption key when selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY 
TYPE].

KEY When selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE]:
Enter WEP key.

Select Characters (ASCII) Hexadecimal digit (HEX)

WEP 64 bit Up to 5 characters Up to 10 characters

WEP 128 bit Up to 13 characters Up to 26 characters

When selecting [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] or [WPA2 
PSK-AES]:
Enter encryption key. Key length must be 8 or greater and 63 or less.

• NAME

PROJECTOR NAME Enter a name for your projector so that your computer can identify the projector. A 
projector name must be 16 characters or less. 
TIP: Projector name will not be affected even when [RESET] is done from the menu.

HOST NAME Enter the hostname of the network connected to the projector. A host name must be 
15 or less.

DOMAIN NAME Enter the domain name of the network connected to the projector. A domain name 
must be 60 characters or less.
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• ALERT MAIL

ALERT MAIL (English 
only)

This option will notify your computer of lamp replace time or error messages via e-mail 
when using wireless or wired LAN. 
Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.
Sample of a message to be sent from the projector:

The lamp and filters are at the end of its usable life. Please replace the lamp and 
filters.
Projector Name: NEC Projector
Lamp Hours Used: 100 [H]

SENDER’S ADDRESS Enter sender’s address. 

SMTP SERVER NAME Enter the SMTP server name to be connected to the projector.

RECIPIENT’S ADDRESS 
1,2,3

Enter your recipient’s address. Up to three addresses can be entered.

TEST MAIL Send a test mail to check whether your settings are correct or not
NOTE:
•	 If you execute a test, you may not receive an Alert mail. Should this happen, check if network 

settings are correct.
•	 If you entered an incorrect address in a test, you may not receive an Alert mail. Should this 

happen, check if the Recipient’s Address is correct.

SAVE Click this button to reflect the above settings.

• NETWORK SERVICE

PJLink PASSWORD Set a password for PJLink*. A password must be 32 characters or less. Do not forget 
your password. However, if you forget your password, consult with your dealer.

HTTP PASSWORD Set a password for HTTP server. A password must be 10 characters or less.

AMX BEACON Turn on or off for detection from AMX Device Discovery when connecting to the network 
supported by AMX’s NetLinx control system.
TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx control system will rec-
ognize the device and download the appropriate Device Discovery Module from an AMX server.
Placing a checkmark will enable detecting the projector from AMX Device Discovery.
Clearing a checkmark will disable detecting the projector from AMX Device Discovery.

*What is PJLink?
PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard proto-
col is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005.
The projector supports all the commands of PJLink Class 1.
Setting of PJLink will not be affected even when [RESET] is done from the menu.

• INFORMATION

WIRED LAN Display a list of settings of wired LAN connection.

WIRELESS LAN Display a list of settings of wireless LAN connection.

UPDATE Reflect settings when they are changed.

 



50

3. Convenient Features

 Controlling the Projector over a LAN (PC Control Utility Pro 4)
Using the utility software “PC Control Utility Pro 4” included on the companion NEC Projector CD-ROM, the projector 
can be controlled from a computer over a LAN.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute*, adjusting, error message notification, 
event schedule.
NOTE:
* Audio mute function is not available on M420XV.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4. For information on how to use PC 
Control Utility Pro 4, see Help of PC Control Utility Pro 4. (→ page 52)

Step 1: Install PC Control Utility Pro 4 on the computer.
Step 2: Connect the projector to a LAN. (→ page 52)
Step 3: Start PC Control Utility Pro 4. (→ page 52)

•	 To run PC Control Utility Pro 4 on Windows XP Home Edition and Windows XP Professional, “Microsoft .NET 
Framework Version 2.0 or later” is required. The Microsoft .NET Framework Version 2.0 or later is available from 
Microsoft’s web page. Download and install the it on your computer. 

TIP:
•	 PC Control Utility Pro 4 can be used with a serial connection.

Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
•	 To install or uninstall the program, the Windows user account must have [Administrator] privilege (Windows 7, Windows Vista 

and Windows XP)
•	 Exit all running programs before installation. If another program is running, the installation may not be completed.

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 the menu window will be displayed.

2	 Click “PC Control Utility Pro 4” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “PC Control Utility Pro 4” (→ page 38)
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Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 110), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 111) and “9. Controlling the Projector by Using an 
HTTP Browser” (→ page 44)

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4”.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/

sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the 
scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer 
to sleep” → “Never”. 
NOTE: 
•	 When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network 

(wired LAN/wireless LAN) connection.

TIP:

Viewing the Help of PC Control Utility Pro 4
•	 Displaying the Help file of PC Control Utility Pro 4 while it is running.

	 Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

	 The pop-up menu will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4 Help”.

	 The Help screen will be displayed.
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 Projecting Your Computer’s Screen Image from the Projector 
over a LAN (Image Express Utility Lite)
 
Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s 
screen image to the projector over a USB cable or a wired or wireless LAN.
This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility 
Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

Step 1: install Image Express Utility Lite on the computer. 
Step 2: Connect the projector to a LAN. (→ page 54)
Step 3: Start Image Express Utility Lite. (→ page 54)

What You can Do with Image Express Utility Lite

• USB Display
•	 Computer’s screen image can be projected via a USB cable, without connecting a computer cable (VGA).

•	 Just connecting the computer and the projector over a USB cable will make the USB Display function available 
(Plug & Play) even without installing Image Express Utility Lite on the computer. (→ page 42)

• Image transmission
•	 The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable 

(VGA).

•	 By using “EASY CONNECTION” function, the complicated network settings can be simplified and the computer 
will automatically connect to the projector.

•	 The screen of your computer can be sent to up to four projectors at the same time.

• Geometric Correction Tool (GCT)
See “⓬ Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”.

Step 1: install Image Express Utility Lite on the computer. 

NOTE:
•	 To install or uninstall the program, the Windows user account must have “Administrator” privilege (Windows 7, Windows Vista 

and Windows XP). 
•	 Exit all running programs before installation. If another program is running, the installation may not be completed. 
•	 Image Express Utility Lite will be installed to the system drive of your computer.
	 If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the 

program.

1.	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.

2. Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE”   in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.

2.	 Click “Image Express Utility Lite” on the menu window.

	 The installation will start.

	 “END USER LICENSE AGREEMENT” screen will be displayed. 

	 Read “END USER LICENSE AGREEMENT” carefully 

3.	 If you agree, click “I agree.” and then click “Next”. 

•	 Follow the instructions on the installer screens to complete the installation. 

•	 When the installation is complete, you will return to the menu window.

	 When the installation is complete, a completion message will be displayed.

4.	 Click “OK”.

	 This completes the installation.

TIP:
• Uninstalling Image Express Utility Lite
To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “Image Express Utility Lite” (→ page 38)

Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 110), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 111) and “9. Controlling the Projector by Using an 
HTTP Browser” (→ page 44)

Step 3: Start Image Express Utility Lite.
1.	 On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility 

Lite” → “Image Express Utility Lite”.

	 Image Express Utility Lite will start.

	 The select window for network connection will be displayed

2.	 Select Network and click “OK”.

	 The select window for destination will show a list of connectable projectors.

•	 When connecting the computer directly to the projector by one-to-one, “Easy Connection” is recommended.

•	 When one or more networks for “EASY CONNECTION” are found, the “Easy Connection Selection Screen” 
window will be displayed.

•	 To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS 
LAN] → [SSID].
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3.	 Select the projector you wish to connect, and click “Connect”.

	 The target selection window will be displayed.

4.	 Place a check mark for projectors to be connected, and then click “Connect”.

•	 When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] 
→ [IP ADDRESS].

	 When connecting with the projector is establised, you can operate the control window to control the projector. (→ 
page 43)

NOTE:
•	 When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed 

in the select window for destination

TIP:

Viewing the Help of Image Express Utility Lite
•	 Displaying the Help file of Image Express Utility Lite while it is running.

	 Click the [?] (help) icon on the control window.

	 The Help screen will be displayed.

•	 Displaying the Help file of GCT while it is running.

	 Click “Help (C)” → “Help” on the Cornerstone Edit screen.

	 The Help screen will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” 
→ “Image Express Utility Lite Help”.

	 The Help screen will be displayed.
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 Projecting an Image from an Angle (Geometric Correction Tool 
in Image Express Utility Lite)
 
The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an 
angle. 

What you can do with GCT

•	 The GCT feature includes the following three functions

•	 4-point Correction: You can fit a projected image within the border of the screen easily by align the four corners 
of an image to the ones of the screen.

•	 Multi-point Correction: You can correct a distorted image on the corner of a wall or irregular shaped screen 
by using many separated screens to correct the image as well as 4-point Correction.

•	 Parameters Correction: You can correct a distorted image by using a combination of transformational rules 
prepared in advance.

This section will show an example for use with 4-point Correction.
For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express 
Utility Lite. (→ page 55) 

•	 Your correction data can be stored in the projector or your computer which can be restored when necessary.

•	 The GCT function is available with a USB cable, wired or wireless LAN connection, and video cable. 

Projecting an Image from an Angle (GCT)
This section will show an example for use with USB Display (using a USB cable to connect a computer and the pro-
jector).
•	 The USB Display function will automatically display the control window 

•	 For a video cable or LAN connection, install and start Image Express Utility Lite in your computer beforehand. (→ 
page 43)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1.	 Click the “   ” (Video) icon and then the “   ” button.

	 The “4-point Correction” screen will be displayed.

2.	 Click the “Start Correction” button and then “Start 4-point Correction” button.

	 A green frame and a mouse pointer (   ) will be displayed.

•	 Four [ • ] marks will be appeared at four corners of the green frame
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3.	 Use the mouse to click the [ • ] mark of which corner you wish to move.

	 The currently selected [ • ] mark will turn red.

(In the above example, Windows screens are omitted for clarification.)

4.	 Drag the selected [ • ] mark to the point you wish to correct and drop it.

•	 When you click somewhere within the project image area, the nearest [ • ] mark will go to the position where 
the mouse cursor is.

5.	 Repeat Step 3 and 4 to correct the distortion of the projected image.

6.	 After completing, right-click the mouse.

	 The green frame and the mouse pointer will disappear from the projected image area. This will complete the cor-
rection.

7.	 Click the “X” (close) button on the “4-point Correction” screen.

	 The “4-point Correction” screen will disappear and the 4-point correction will take effect.

8.	 Click the “   ” button on the control window to exit the GCT.

TIP:
•	 After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Writing to 

the projector…” on the “4-point Correction” screen.
•	 See the Help of Image Express Utility Lite for operating “4-point Correction” screen and other functions than GCT. (→ page 55)



58

4. Using the Viewer
❶ What you can do with the Viewer
The Viewer has the following features.

•	 When a commercially available USB memory that stores image files is inserted into the USB port (Type A) of the 
projector, the Viewer allows you to view the image files on the USB memory.

	 Even if no computer is available, presentations can be conducted simply with the projector. 

•	 Supported graphic format is JPEG.

•	 The Viewer displays the thumbnail screen (JPEG Exif only) on which you can jump to any specific image you wish 
to project.

•	 There are two ways of playback for slideshow: manual playback and auto playback. The interval time can be 
changed in auto playback.

•	 The order of displaying images can be set by name, date or size. Ascending or descending order can be se-
lected.

•	 Images can be rotated by 90 degrees during playback.
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NOTE
•	 The USB port of the projector does not support USB hub. 
•	 The following operations by using the buttons on the projector are not possible when the VIEWER screen such as the slide screen 

and the thumbnail screen is displayed.
-	 Keystone correction by using the ▲/▼ button
-	 Auto Adjustment by using the ◀ or AUTO ADJ. button
-	 Volume control with the ◀ or ▶ button
	 To perform Keystone correction or Source selection during display of the Viewer, press the MENU button twice to display the 

menu and operate Viewer from the menu.
•	 Freezing picture by using the FREEZE button on the remote control is not possible when the VIEWER screen such as the slide 

screen and the thumbnail screen is displayed.
•	 Executing [RESET] → [ALL DATA] from the menu will return the settings for the Viewer toolbar to the factory default.
•	 USB memory

-	 Be sure to use a USB memory device formatted with the FAT32 or FAT16 file system. 
	 The projector does not support NTFS formatted USB memory.
	 If the projector does not recognize your USB memory, check if the format is supported.
	 To format your USB memory in your computer, refer to the document or help file that comes with your Windows.
-	 We do not warrant that the USB port of the projector will support all USB memories in the market.

•	 Supported images
-	 Supported file format for Viewer are as follows.
	 We do not warrant all the images are supported for Viewer.
	 Images other than mentioned in the table may not be supported.

Image type Extension Description

JPEG JPG/JPEG Baseline/Exif are supported

-	 Slideshow, effect, and sound effect set with PowerPoint cannot be played back.
-	 Image can be displayed at a resolution up to 10000 × 10000 pixels.
-	 Even if images are met by the above conditions, there may be some images which cannot be played back.
-	 More than 200 icons (total number of image file icons and folder icons) cannot be displayed in a thumbnail screen.
-	 Long file/folder name will be limited to the specified length. This can be shown by bracket added.
-	 If one folder has many files, it takes some time to play back.

•	 If a single folder contains too many files, switching images will take time. To shorten switching time, reduce the number of images 
contained in a single folder.

TIP: Exchangeable image file format (Exif) is a standard image file format used by digital cameras with the addition of specific 
shooting data.
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❷ Projecting images stored in a USB memory device
This section explains the basic operation of the Viewer. 
The explanation provides the operational procedure when the Viewer toolbar (→ page 64) is set to the factory de-
fault.

- Starting the Viewer........................................................................below
- Removing the USB memory from the projector........................ page 62
- Exiting the Viewer..................................................................... page 62

Preparation: Before starting the Viewer, store images to the USB memory using your computer.

WIRELESS

WIRELESS

Starting the Viewer
1.	 Turn on the projector. (→ page 16)

2.	 Insert the USB memory into the USB port of the projec-
tor.

•	 Do not remove the USB memory from the projector while 
it’s LED flashes. Doing so may corrupt the data.

3.	 Press the SOURCE button on the projector cabinet.

	 The Viewer start screen will be displayed.

•	 Press the VIEWER button on the remote control.
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4.	 Press the ENTER button.

	 The thumbnail screen will be displayed. (→ page 63)

5.	 Use the ▲▼◀ or ▶ button to select an icon.

•	 The → (arrow) symbol on the right indicates there are more 
pages. pressing the PAGE ▽ (page down) button will show 
the next page: pressing the PAGE △ (page up) will show 
the previous page.

6.	 Press the ENTER button.

	 The selected slide will be displayed.

•	 When a folder icon is selected, icons contained in the folder 
will be displayed.

7.	 Press the ▶ button to select the next slide.

	 The slide on the right will be displayed.

•	 The ◀ or ▶ button can be used to select the next (right) 
slide or the previous (left) slide in the thumbnail screen.

•	 Pressing the MENU button during display of the thumbnail 
screen, the slide screen, or the slideshow screen will display 
the toolbar. The toolbar is used to select or rotate an slide.
(→ page 64)

8.	 Press the EXIT button when the toolbar is not dis-
played.

	 The thumbnail screen will be displayed.

•	 Another way to display the thumbnail screen is to press the 
ENTER button.

•	 To close the toolbar, press the MENU button to return to the 
SOURCE list, and press the MENU button again to close 
the SOURCE list.
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Removing the USB memory from the pro-
jector
1.	 Select the VIEWER start screen.

	 Press the EXIT button with no menu displayed.

2.	 Remove the USB memory from the projector.

	 Make sure that the LED on the USB memory is not 
flashing before removing the USB memory.

NOTE: If you remove the USB memory from the projector with 
a slide displayed, the projector may not operate correctly. If 
this happens, turn off the projector and unplug the power 
cord. Wait 3 minutes, then connect the power cord, and turn 
on the projector.

Exiting the Viewer
1.	 Press the MENU button with the slide screen or 

the thumbnail screen displayed.

	 The control bar or the pop-up menu will be dis-
played.

2.	  Press the MENU button again.

	 The on-screen menu will be displayed.

3.	 Select a source other than [VIEWER] and press 
the ENTER button.

	 The Viewer will be exited.

TIP: To exit the Viewer using the remote control, select a source 
other than [VIEWER].

WIRELESS

WIRELESS
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Parts of each screen
The Viewer has four screens.

(1) Viewer start screen (3) Thumbnail screen (9) Slide screen/
(11) Slideshow screen

Name Description

(1) Viewer start screen This screen will be displayed first when you select the Viewer.

(2) USB icon This icon indicates that the USB memory is inserted into the projector.

(3) Thumbnail screen This screen will show a list of folders and image files stored in the USB memory. The 
JPEG Exif files will be displayed in thumbnail screen only.
•	 The maximum number of image files or folders within one page is different depending 

on the model.
	 M350X, M300X, M260X, M230X, M420X, M420XV, M350XS, M300XS, and M260XS 

are 5 by 4
	 M300W, M260W, M300WS, and M260WS are 6 by 4

(4) Cursor The cursor is used to select (highlight) the folder or image file by using ▲▼◀▶ but-
ton.

(5) Back icon This icon is used to return to the upper (parent) folder.

(6) Folder icon This icon shows that the USB memory has folders.

(7) �Page up (Page down) 
icon

This icon shows further folders or image files are available in the next (previous) page. 
Use the ▶ button to go to the next (previous) row. The PAGE ▽ or PAGE △ on the 
remote control is used to go to the next or previous page directly.

(8) Thumbnail toolbar This toolbar is used in the thumbnail screen. Pressing the MENU button will display 
this toolbar. (→ page 64)

(9) Slide screen This screen is used for manual playback. The selected image will be displayed in full 
screen.

(10) Slide toolbar This toolbar is used in the slide screen. Pressing the MENU button will display this 
toolbar. (→ page 65)

(11) Slideshow screen This screen is used for auto playback. The slides will be changed automatically.

(12) Slideshow toolbar This toolbar is used in the slideshow screen. Pressing the MENU button will display 
this toolbar. (→ page 65)

(5) (6) (4) (7)

(8)(2) (10) (12)
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Using the toolbar

1.	 Press the MENU button.

	 The toolbar will be displayed.

	 The SOURCE screen will be displayed as Viewer connection screen.

2.	 Use the ◀ or ▶ button to select an item and use the ▲ or ▼ button to select its available option.

	 When the cursor is placed, the selected item will be changed to yellow.

	 The ▲ or ▼ shows more available choices.

3.	 Press the ENTER button.

	 The selected item will be displayed.

4.	 Press the MENU button two times.

	 The toolbar will be closed and the SOURCE list will be displayed. Press the MENU button again to close the 
SOURCE list.

Thumbnail toolbar

Menu Options Description

(1) Back — Goes back to the previous image. When the cursor reaches the top left of 
the screen, it will go to the previous page.

(2) Forward — Goes to the next image. When the cursor reaches the bottom right of the 
screen, it will go to the next page.

(3) Display Closes the menu and returns to the thumbnail screen.

Closes the menu and starts the slideshow from the highlighted item.

Closes the menu and displays the slide screen.

(4) Order Displays the icons alphabetically by name. (number before alphabet)

Displays the icons in descending order of file size.

Displays the icons in the order of creation date

(1) (2) (3) (4)
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Slide toolbar

Menu Options Description

(1) Display Closes the menu and switches to the slide screen.

Closes the menu and displays the thumbnail screen.

Closes the menu and starts the slideshow from the highlighted item.

(2) �Image 
display

Closes the menu and displays the image in its actual size.

Closes the menu and displays the image in the projector’s maximum reso-
lution.

(3) �Clockwise 
rotation

— Close the menu and rotate the image 90°clockwise

(4) �Counter-
clockwise 
rotation

— Close the menu and rotate the image 90°counter clockwise

Slideshow toolbar

Menu Options Description

(1) Stop — Closes the menu and changes to the slide screen.

(2) Back — Goes back to the previous image.

(3) Forward — Goes to the next image.

(4) Interval Specifies interval time when playing back the slides.

(5) Repeat Repeats to play back the images in the folder.

Returns to the thumbnail screen.

TIP:
•	 A picture icon at the center of the screen shows that the file cannot be displayed in the slide screen or thumbnail screen.
•	 Slide toolbar setting for rotation will be cancelled if the folder is moved from one place to another.

(1) (2) (3) (4)

(1) (2) (3) (4) (5)
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3 Converting PowerPoint files to Slides (Viewer PPT Converter 
3.0)

Using Viewer PPT Converter 3.0 contained on the supplied NEC Projector CD-ROM allows you to convert Power-
Point files into JPEG files. Converted JPEG files can be saved to a USB memory. When the USB memory inserted 
into the projector, these JPEG files can be displayed with the viewer function of the projector without connecting a 
computer.

NOTE:
By using PPT Converter 3.0, PowerPoint file is converted into index file (with extension “.idx”)
When conversion is done, index file (with extension “.idx”) will be created. At the same time a folder with the same name will be 
created where JPEG files will be saved to. The projector's Viewer does not support index file (with extension .idx).

Install Viewer PPT Converter 3.0 on the computer.

NOTE:
•	 To install or uninstall the program, the Windows user account must have “Administrator” privilege (Windows 7, Windows Vista 

and Windows XP). 
•	 Exit all running programs before installation. If another program is running, the installation may not be completed. 

1.	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE”   in “Name”. (example: Q:\
LAUNCHER.EXE)

4	 Click “OK”.

	 The menu window will be displayed.



67

4. Using the Viewer

2.	 Click “Install Viewer PPT Converter 3.0” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed. 

	 Read “END USER LICENSE AGREEMENT” carefully 

4.	 If you agree, click “I accept the terms in the license agreement” and then click “Next”. 

•	 Follow the instructions on the installer screens to complete the installation. 

•	 When the installation is complete, you will return to the menu window.

NOTE:
When Viewer PPT Converter 3.0 has been installed, once start Viewer PPT Converter 3.0 once with the privilege used for installation. 
Then exit from Viewer PPT Converter 3.0 without doing anything.
• Starting
Click Window’s [Start] → [All Programs] → [NEC Projector User Supportware] → [Viewer PPT Converter 3.0] → [Viewer PPT 
Converter 3.0], in that order.

NOTE:
When installing Viewer PPT Converter 3.0 onto a personal computer that has PowerPoint installed, Viewer PPT Converter 3.0 is 
automatically registered as a Power-Point add-in.
It is necessary to cancel Viewer PPT Converter 3.0 add-in before uninstalling Viewer PPT Converter 3.0.
Refer to Viewer PPT Converter 3.0 Help to unregister the add-in.

TIP:
• Uninstalling Viewer PPT Converter 3.0
To uninstall Viewer PPT Converter 3.0, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “Viewer PPT Converter 3.0” (→ page 38)
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Converting PowerPoint files and saving them to a USB memory
1.	 Insert the USB memory into the USB port of the computer.

2.	 On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Viewer PPT Converter 
3.0” → “Viewer PPT Converter 3.0”.

	 Viewer PPT Converter 3.0 will start.

3. Click “Brows...” and select a PowerPoint file you wish to convert, and then click “Open”.

4. 	Click “Next”.

5.	 Select the USB memory drive for “Card Drive” and type in “Index name”.

	 Index name must be eight alphanumeric characters or less. 2-byte character and file with a long filename cannot 
be used.

6.	 Click “Export”.

	 A confirmation message will be displayed.

7.	 Click “OK”.

	 Exporting a file will start.

8.	 Click “OK”.

9.	 Click “Exit”.

	 Viewer PPT Converter 3.0 will exit.

10. Remove the USB memory from the computer.

NOTE:
•	 Before removing the USB memory from the USB port of the computer, click the “Safe to Remove Hardware” icon on the task-

bar.
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 Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1.	 Press the MENU button on the remote control or the projector cabinet to display the menu.

NOTE: The commands such as ENTER, EXIT, ,  in the bottom show available buttons for your operation.

2.	 Press the  buttons on the remote control or the projector cabinet to display the submenu.

3.	 Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first 
tab.

4.	 Use the  buttons on the remote control or the projector cabinet to select the item you want to adjust or 
set.

	 You can use the  buttons on the remote control or the projector cabinet to select the tab you want.

5.	 Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6.	 Adjust the level or turn the selected item on or off by using the  buttons on the remote control or 
the projector cabinet.

Changes are stored until adjusted again.

7.	 Repeat steps 2 -6 to adjust an additional item, or press the EXIT button on the remote control or the projec-
tor cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. 	Press the MENU button to close the menu.

	 To return to the previous menu, press the EXIT button.
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2 Menu Elements
Slide bar

Solid triangle

Tab

Radio button

High Altitude symbol

ECO mode symbol

Wireless symbol

Menu windows or dialog boxes typically have the following elements:

Highlight	����������������������������� Indicates the selected menu or item. 
Solid triangle	���������������������� Indicates further choices are available. A highlighted triangle indicates the item is active. 
Tab	�������������������������������������� Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button	�����������������������Use this round button to select an option in a dialog box.
Source	�������������������������������� Indicates the currently selected source.
Off Timer remaining time	���� Indicates the remaining countdown time when the [OFF TIMER] is preset.
Slide bar	����������������������������� Indicates settings or the direction of adjustment.
ECO mode symbol	�������������� Indicates ECO MODE is set.
Key Lock symbol	���������������� Indicates the [CONTROL PANEL LOCK] is enabled.
Thermometer symbol	��������� Indicates the [ECO MODE] is forcibly set to [ON] mode because the internal temperature is too 

high.
High Altitude symbol	���������� Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
Wireless symbol	����������������� Indicate the wireless LAN connection is enabled.

Source

Available buttons

Thermometer symbol

Key Lock symbol

Off Timer remaining 
time

Highlight
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3 List of Menu Items
Some menu items are not available depending on the input source.
Menu Item Default Options

SOURCE

COMPUTER1 *
COMPUTER2 *
HDMI *
VIDEO *
S-VIDEO *
VIEWER *
NETWORK *
USB DISPLAY *

ADJUST

PICTURE

PRESET * 1–7

DETAIL 
SETTINGS

GENERAL

REFERENCE * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, 
sRGB, DICOM SIM.

GAMMA 
CORRECTION*1 DYNAMIC, NATURAL, BLACK DETAIL

SCREEN SIZE*2 * LARGE, MEDIUM, SMALL
COLOR 
TEMPERATURE * 5000, 6500, 7800, 8500, 9300, 10500

DYNAMIC 
CONTRAST * OFF, ON

IMAGE MODE * STILL, MOVIE
WHITE BALANCE
CONTRAST R 0
CONTRAST G 0
CONTRAST B 0
BRIGHTNESS R 0
BRIGHTNESS G 0
BRIGHTNESS B 0

CONTRAST
BRIGHTNESS
SHARPNESS
COLOR*1

HUE
RESET

IMAGE 
OPTIONS

CLOCK *
PHASE *
HORIZONTAL *
VERTICAL *
OVERSCAN * 0[%], 5[%], 10[%]

ASPECT RATIO
* M420X/M350X/M300X/M260X/M230X/M420XV/M350XS/M300XS/

M260XS: AUTO, 4:3, 16:9, 15:9, 16:10, WIDE ZOOM, NATIVE

* M300W/M260W/M300WS/M260WS: AUTO, 4:3, 16:9, 15:9, 
16:10, LETTERBOX, NATIVE

POSITION 0 (Not available on M300W/M260W/M300WS/M260WS)

SETUP

GENERAL

DIGITAL ZOOM*3 100% 80–100%
AUTO KEYSTONE ON OFF, ON
KEYSTONE 0
KEYSTONE SAVE OFF OFF, ON

WALL COLOR OFF
OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD 
(GRAY), LIGHT YELLOW, LIGHT GREEN, LIGHT BLUE, 
SKY BLUE, LIGHT ROSE, PINK

ECO MODE AUTO ECO OFF, AUTO ECO, ECO1, ECO2*4

CLOSED CAPTION OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, 
TEXT1, TEXT2, TEXT3, TEXT4

OFF TIMER OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00

LANGUAGE ENGLISH

ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, 
SVENSKA, 日本語
DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, 
NEDERLANDS, SUOMI
NORSK, TÜRKÇE, РУССКИЙ, , Ελληνικά, 中文, 한국어
ROMÂNĂ, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, 
ไทย

MENU

COLOR SELECT COLOR COLOR, MONOCHROME
SOURCE DISPLAY ON OFF, ON
ID DISPLAY ON OFF, ON
ECO MESSAGE OFF OFF, ON
DISPLAY TIME AUTO 45 SEC MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC
BACKGROUND BLUE BLUE, BLACK, LOGO
FILTER MESSAGE OFF OFF, 100[H], 500[H], 1000[H], 2000[H]

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
*1	 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
*2	 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
*3	 [DIGITAL ZOOM] is available on M350XS, M300XS, M260XS, M300WS, and M260WS only.
*4	 [ECO2] is available on M300X, M260X, and M260XS only.
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SETUP

INSTALLATION

ORIENTATION DESKTOP FRONT DESKTOP FRONT, CEILING REAR, DESKTOP REAR, 
CEILING FRONT

CONTROL PANEL LOCK OFF OFF, ON
SECURITY OFF OFF, ON
COMMUNICATION SPEED 38400bps 4800bps, 9600bps, 19200bps, 38400bps

CONTROL ID
CONTROL ID 
NUMBER 1 1–254

CONTROL ID OFF OFF, ON
TEST PATTERN

OPTIONS(1)

AUTO ADJUST NORMAL OFF, NORMAL, FINE
FAN MODE AUTO AUTO, HIGH, HIGH ALTITUDE

SIGNAL SELECT

COMPUTER1 RGB/COMPONENT RGB/COMPONENT, RGB, COMPONENT
COMPUTER2 RGB/COMPONENT RGB/COMPONENT, RGB, COMPONENT

VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 
SECAM

S-VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 
SECAM

WXGA MODE

M420X/M350X/M300X/
M260X/M230X/M420XV/

M350XS/M300XS/
M260XS: OFF 

M300W/M260W/
M300WS/M260WS: ON

OFF, ON

DEINTERLACE ON OFF, ON

HDMI SETTINGS
VIDEO LEVEL AUTO AUTO, NORMAL, ENHANCED
AUDIO SELECT* HDMI HDMI, COMPUTER2

BEEP* ON OFF, ON

OPTIONS(2)

STANDBY MODE NORMAL NORMAL, POWER-SAVING
AUTO POWER ON(AC) OFF OFF, ON
AUTO POWER ON(COMP1) OFF OFF, ON
AUTO POWER OFF OFF OFF, 0:05, 0:10, 0:20, 0:30

DEFAULT SOURCE SELECT LAST LAST, AUTO, COMPUTER1, COMPUTER2, HDMI, VIDEO, 
S-VIDEO, VIEWER, NETWORK, USB DISPLAY

WIRED LAN

WIRED LAN ENABLE DISABLE, ENABLE

SETTINGS DHCP: ON
AUTO DNS: ON

DHCP, IPADDRESS, SUBNET MASK, GATEWAY, 
AUTO DNS, DNS

RECONNECT

WIRELESS LAN
PROFILE EASY CONNECTION DISABLE, EASY CONNECTION, PROFILE1, PROFILE2
RECONNECT

INFO.

USAGE TIME

LAMP LIFE REMAINING
LAMP HOURS USED
FILTER HOURS USED
TOTAL CARBON SAVINGS

SOURCE

SOURCE NAME
SOURCE INDEX
HORIZONTAL FREQUENCY
VERTICAL FREQUENCY
SIGNAL TYPE
VIDEO TYPE
SYNC TYPE
SYNC POLARITY
SCAN TYPE

WIRED LAN

IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS

WIRELESS LAN

IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS
SSID
NETWORK TYPE
WEP/WPA
CHANNEL
SIGNAL LEVEL

VERSION
FIRMWARE
DATA

OTHERS

PROJECTOR NAME
MODEL NO.
SERIAL NUMBER
LAN UNIT TYPE
CONTROL ID (when [CONTROL ID] 
is set)

RESET

CURRENT SIGNAL
ALL DATA
CLEAR LAMP HOURS
CLEAR FILTER HOURS

*	 The item with an asterisk(*) is not available on M420XV.
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4 Menu Descriptions & Functions [SOURCE]

COMPUTER 1 and 2
Selects the computer connected to your COMPUTER 1 or COMPUTER 2 input connector signal.

NOTE: When the component input signal is connected to the COMPUTER 1 IN or COMPUTER 2 IN connector, select [COMPUTER 
1] or [COMPUTER 2] respectively.

HDMI
Selects the HDMI compatible equipment connected to your HDMI IN connector.

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

S-VIDEO
Selects what is connected to your S-VIDEO input-VCR or DVD player.

NOTE: A frame may freeze for a brief period of time when a video is played back in fast-forward or fast-rewind with a Video or S-
Video source.

VIEWER
This feature enables you to make presentations using a USB memory that contains slides.
(→ page 58 “4. Using the Viewer”)

NETWORK
Selects a signal from the LAN port (RJ-45) or the installed USB wireless LAN unit (optional).

USB DISPLAY
Selects the computer connected to the USB(PC) port (type B) by using a commercially available USB cable. 
(→ page 42)



74

5. Using On-Screen Menu

5 Menu Descriptions & Functions [ADJUST]
[PICTURE]

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta. 
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set 
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values
DICOM SIM.	���������� Recommended for DICOM simulation format.

NOTE: 
•	 The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
•	 DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiol-

ogy (ACR) and the National Electrical Manufacturers Association (NEMA). 
	 The standard specifies how digital image data can be moved from system to system. 

[DETAIL SETTINGS]
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[GENERAL]
Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERA-
TURE]. 

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values.
DICOM SIM.	���������� Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

DYNAMIC	�������������� Creates a high-contrast picture.
NATURAL	��������������� Natural reproduction of the picture.
BLACK DETAIL	������� Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

LARGE	������������������� For screen size of 150"
MEDIUM	���������������� For screen size of 100"
SMALL	������������������� For screen size of 50"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris.
To increase the contrast ratio, select [ON].

Selecting Still Image Mode or Movie Mode [IMAGE MODE]
This function allows you to select the still image mode or the movie mode.

STILL	��������������������� This mode is for a still image.
MOVIE	������������������� This mode is for a movie.

NOTE: This function is available only when [HIGH-BRIGHT] is selected for [REFERENCE].

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; 
Brightness for each color (RGB) is used to adjust the black level of the screen.
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[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/− green to +/− blue. The red level is used as reference.

Input signal CONTRAST BRIGHTNESS SHARPNESS COLOR HUE

COMPUTER/HDMI (RGB) Yes Yes Yes No No

COMPUTER/HDMI (COMPONENT) Yes Yes Yes Yes Yes

VIDEO/S-VIDEO/COMPONENT Yes Yes Yes Yes Yes

VIEWER/NETWORK/USB DISPLAY Yes Yes Yes No No

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; 
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected 
will not be reset.
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[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK	������������������� Use this item to fine tune the computer image or to remove any vertical banding that might appear. This 
function adjusts the clock frequencies that eliminate the horizontal banding in the image.
This adjustment may be necessary when you connect your computer for the first time.

PHASE	������������������� Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is 
evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
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Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

NOTE: The [HORIZONTAL] and [VERTICAL] items are not available for VIDEO, S-VIDEO, HDMI, VIEWER, NETWORK, and USB 
DISPLAY.

-	 An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.

-	 The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the 
current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, 
its adjustments will be called up and applied.

	 To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL 
DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (0%, 5% and 10%) for signal.

Projected image

Overscaned by 10%

NOTE: 
•	 The [0[%]] cannot be selected when VIDEO and S-VIDEO signals are used.
•	 The [OVERSCAN] item is not available:
	 • �when [NATIVE] is selected for [ASPECT RATIO].
	 • �when [VIEWER], [NETWORK], or [USB DISPLAY] is selected for [SOURCE]
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Selecting Aspect Ratio [ASPECT RATIO]
The term “aspect ratio” refers to the ratio of width to height of a projected image.
The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.
• This table shows typical resolutions and aspect ratios that most computers support.

Resolution Aspect Ratio
VGA 	 640 × 480 	 4:3
SVGA 	 800 × 600 	 4:3
XGA 	 1024 × 768 	 4:3
WXGA 	 1280 × 768 	 15:9
WXGA 	 1280 × 800 	 16:10
WXGA+ 	 1440 × 900 	 16:10
SXGA 	 1280 × 1024 	 5:4
SXGA+ 	 1400 × 1050 	 4:3
UXGA 	 1600 × 1200 	 4:3

Options Function
AUTO The projector will automatically determine the incoming signal and display it in its aspect 

ratio. (→ next page)
The projector may erroneously determine the aspect ratio depending on its signal. If this 
occurs, select the appropriate aspect ratio from the following.

4:3 The image is displayed in 4:3 aspect ratio.
16:9 The image is displayed in 16:9 aspect ratio.
15:9 The image is displayed in 15:9 aspect ratio.
16:10 The image is displayed in 16:10 aspect ratio.
WIDE ZOOM
(M350X/M300X/M260X/
M230X/M420X/M420XV/
M350XS/M300XS/
M260XS)

The image is stretched left and right. 
Parts of the displayed image are cropped at the left and right edges and therefore not 
visible.

LETTERBOX
(M300W/M260W/
M300WS/M260WS)

The image of a letterbox signal is stretched equally in the horizontal and vertical directions 
to fit the screen. Parts of the displayed image are cropped at the top and bottom edges 
and therefore not visible.

NATIVE The projector displays the current image in its true resolution when the incoming computer 
signal has a lower resolution than the projector’s native resolution.

[Example 1] When the incoming sig-
nal with the resolution of 800 × 600 
is displayed on the M350X/M300X/
M260X/M230X/M420X/M420XV/
M350XS/M300XS/M260XS:

[Example 2] When the incoming sig-
nal with the resolution of 800 × 600 
is displayed on the M300W/M260W/
M300WS/M260WS:

NOTE:
•	 When a non-computer signal is displayed, the [NATIVE] is not available.
•	 When a signal with a higher resolution than the projector’s native resolution is displayed, [NATIVE] 

is not available.



80

5. Using On-Screen Menu

Sample image when the appropriate aspect ratio is automatically determined
M350X/M300X/M260X/M230X/M420X/M420XV/M350XS/M300XS/M260XS
[Computer signal]
Aspect ratio of incoming signal 4:3 5:4 16:9 15:9 16:10

Sample image when the appro-
priate aspect ratio is automati-
cally determined

[Video signal]
Aspect ratio of incoming signal 4:3 Letterbox Squeeze

Sample image when the as-
pect ratio is automatically de-
termined

NOTE: To display a squeezed signal prop-
erly, select [16:9] or [WIDE ZOOM].

M300W/M260W/M300WS/M260WS
[Computer signal]
Aspect ratio of incoming signal 4:3 5:4 16:9 15:9 16:10

Sample image when the appro-
priate aspect ratio is automati-
cally determined

[Video signal]
Aspect ratio of incoming signal 4:3 Letterbox Squeeze

Sample image when the as-
pect ratio is automatically de-
termined

NOTE: To display a letterbox signal prop-
erly, select [LETTERBOX].

NOTE: To display a squeezed signal prop-
erly, select [16:9].

TIP:
•	 Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
•	 The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect 

ratio for a vide source.
	 The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
•	 The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

Adjusting the Vertical Position of Image [POSITION] (not available on M300W/M260W/M300WS/
M260WS)
(only when [16:9], [15:9], or [16:10] is selected for [ASPECT RATIO])

When [16:9], [15:9], or [16:10] is selected in [ASPECT RATIO], the image is displayed with black borders on the top 
and bottom.
You can adjust the vertical position from the top to the bottom of the black area.
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6 Menu Descriptions & Functions [SETUP]

[GENERAL]

[M350X/M300X/M260X/M230X/M300W/M260W/
M420X/M420XV]

[M350XS/M300XS/M260XS/M300WS/M260WS]

Using Digital Zoom [DIGITAL ZOOM] (M350XS/M300XS/M260XS/M300WS/M260WS) 
This feature allows you to electronically fine adjust the image size on the screen. Use the ◀ or ▶ button to large or 
reduce the projected image. 

TIP: To adjust the projected image size roughly, move the projector away or closer to the screen. To fine adjust the zoom, use the 
[DIGITAL ZOOM] function. (→ page 21)

Enabling Auto Keystone [AUTO KEYSTONE]
This feature allows the projector to detect its tilt and correct vertical distortion automatically.
To turn on the AUTO KEYSTONE feature, select [ON]. To adjust the KEYSTONE feature manually, select [OFF].

NOTE: The [AUTO KEYSTONE] function is not available when an orientation type such as [CEILING REAR], [DESKTOP REAR], 
[CEILING FRONT] other than [DESKTOP/FRONT] is selected for [ORIENTATION].

TIP:
•	 The range of the AUTO KEYSTONE correction varies depending on the model name.
	 M420X/M420XV/M350X/M300X/M260X/M230X/M300W/M260W: up to 30 degrees (vertical)
	 M350XS/M300XS/M260XS/M300WS/M260WS: up to 20 degrees (vertical)
•	 The AUTO KEYSTONE correction will take effect in 2 seconds after changing the projection angle during projection.

Correcting Vertical Keystone Distortion Manually [KEYSTONE]
You can correct vertical distortion manually. (→ page 24)

TIP: When this option is highlighted, pressing the ENTER button will display its slide bar for adjustment.

Saving Vertical Keystone Correction [KEYSTONE SAVE]
This option enables you to save your current keystone settings.

OFF	������������������������ Does not save current keystone correction settings. It will return your keystone correction settings to 
“zero”.

ON	������������������������� Saves current keystone correction settings

Saving your change once affects all sources. The changes are saved when the projector is turned off.

NOTE: When [AUTO KEYSTONE] is set to [ON], [KEYSTONE SAVE] is not available. Next time you turn on the power, the AUTO 
KEYSTONE function will work and the data stored with [KEYSTONE SAVE] will be invalid.
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Using the Wall Color Correction [WALL COLOR]

	

This function allows for quick adaptive color correction in applications where the screen material is not white.

NOTE: Selecting [WHITEBOARD] reduces lamp brightness.

Setting Eco Mode [ECO MODE]
The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO2 emissions. 
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [ECO1] and [ECO2] modes. 
(→ page 30)
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Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video 
or S-Video.

OFF	������������������������ This exits the closed caption mode.
CAPTION 1-4	��������� Text is superimposed.
TEXT 1-4	���������������� Text is displayed.
NOTE:
•	 The closed caption is not available under the following conditions:

-	 when messages or menus are displayed.
-	 when an image is magnified, frozen, or muted.

•	 Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or 
closed caption within the screen.

Using Off Timer [OFF TIMER]
1.	 Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.

2.	 Press the ENTER button on the remote control.

3.	 The remaining time starts counting down.

4.	 The projector will turn off after the countdown is complete.

NOTE:
•	 To cancel the preset time, set [OFF] for the preset time or turn off the power.
•	 When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 

MINUTES] message will be displayed on the bottom of the screen.

Selecting Menu Language [LANGUAGE]
You can choose one of 27 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

[MENU]

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as COMPUTER 1, COMPUTER2, HDMI, VIDEO, S-VIDEO, 
VIEWER, NETWORK, USB DISPLAY, to be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed 
at the center of the screen. When the [VIEWER] or [NETWORK] item is selected for [SOURCE], the no-signal guid-
ance will not be displayed.
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Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY	����������� This option turns on or off the ID number which is displayed when the ID SET button on the remote control 

is pressed.

Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on. 

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message 
to prompt you to select [AUTO ECO], [ECO1], or [ECO2]* for [ECO MODE].

When [AUTO ECO], [ECO1], or [ECO2]* is selected for [ECO MODE]

NOTE: * [ECO2] is available on M300X, M260X, and M260XS only. 

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 
30 seconds.

When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 30)
To close the message, press the EXIT button.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The 
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is 
[BLUE].
NOTE: 
•	 If the [LOGO] item is selected for [BACKGROUND] with the [NETWORK] or [USB DISPLAY] source selected, the [BLUE] item will 

be selected regardless of its selection.
•	 When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed 

at the center of the screen regardless of its selection.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean 
the filter when you get the message “PLEASE CLEAN FILTER.” (→ page 115)
Five options are available: OFF, 100[H], 500[H], 1000[H], 2000[H]
The default setting is [OFF].

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, 
desktop rear projection, and ceiling front projection.

DESKTOP FRONT CEILING REAR

DESKTOP REAR CEILING FRONT

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
•	 This CONTROL PANEL LOCK does not affect the remote control functions.
•	 When the control panel is locked, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will change 

the setting to [OFF].

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [  ] will be displayed at the bottom right of the menu.

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 32)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The 
default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equip-
ment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL 
ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together 
using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER	�������Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID	�����������������������Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID set-

ting.

NOTE: 
•	 When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support 

the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
•	 Your setting will not be affected even when [RESET] is done from the menu.
• 	Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control 

ID.

Assigning or Changing the Control ID
1.	 Turn on the projector.

2.	 Press the ID SET button on the remote control.

	 The CONTROL ID screen will be displayed.

	 If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector 
cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive 
projector, assign the control ID used for the projector by using the following procedure (Step 3).

3.	 Press one of numeric keypad buttons while pressing and holding the ID SET 
button on the remote control.

	 Example:

	 To assign “3”, press the “3” button on the remote control.

	 No ID means that all the projectors can be operated together with a single remote 
control. To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.

4.	 Release the ID SET button.

	 The updated CONTROL ID screen will be displayed.

NOTE: 
• 	The IDs can be cleared in a few days after the batteries are run down or removed.
• 	Accidentally pressing any one of the buttons of the remote control will clear currently specified 

ID with batteries removed.
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Using Test Pattern [TEST PATTERN]
Displays the test pattern to check for image distortion at the time of the projector setup. Press the ENTER button to 
display the test pattern; press the EXIT button to close the test pattern and return to the menu. Menu operation and 
keystone correction are not possible when the test pattern is displayed.

[OPTIONS(1)]

[M350X/M300X/M260X/M230X/M300W/M260W/
M420X/M350XS/M300XS/M260XS/M300WS/
M260WS]

[M420XV]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for 
noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF	������������������������ The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL	���������������� Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE	����������������������� Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NOR-

MAL]is selected.

Selecting Fan Mode [FAN MODE]
This option allows you to select three modes for fan speed: Auto mode, High speed mode, and High Altitude mode.

AUTO	��������������������� The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH	���������������������� The built-in fans run at high speed.
HIGH ALTITUDE	����� The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 

5500 feet/1600 meters or higher.

When you wish to cool down the temperature inside the projector quickly, select [HIGH].

NOTE: 
•	 It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
• 	Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher.
•	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause 

the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• 	Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the 

lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
• 	Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical components such 

as the lamp.
•	 Your setting will not be affected even when [RESET] is done from the menu.
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Selecting Signal Format [SIGNAL SELECT]
[COMPUTER1], [COMPUTER2]
Allows you to choose [COMPUTER1], or [COMPUTER2] for an RGB source such as a computer, or [COMPONENT] 
for a component video source such as a DVD player. Normally select [RGB/COMPONENT] and the projector auto-
matically detects a component signal. However there may be some component signals that the projector is unable to 
detect. If this is the case, select [COMPONENT].

[VIDEO & S-VIDEO System Select]
This feature enables you to select composite video standards automatically or manually.
Normally select [AUTO] and the projector will automatically detect the video standard.
In the case where the projector has difficulty detecting the video standard, select the appropriate video standard from 
the menu.
This must be done for VIDEO and S-VIDEO respectively.

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to a WXGA (1280 × 768) signal in recognizing an input signal.
When [WXGA MODE] is set to [ON], an XGA (1024 × 768) signal may not be recognized on M350X/M300X/M260X/
M230X/M420X/M420XV/M350XS/M300XS/M260XS. In this case, select [OFF].

NOTE: 
•	 The [OFF] is selected at the time of shipment of M350X/M300X/M260X/M230X/M420X/M420XV/M350XS/M300XS/M260XS.
•	 The [ON] is selected at the time of shipment of M300W/M260W/M300WS/M260WS.

Enabling the deinterlace [DEINTERLACE]
Turns on or off the deinterlace function for a telecine signal.

OFF	������������������������ Select this option if there is any jitter or artifacts in video.
ON	������������������������� Default standard setting.

NOTE: This feature is not available for HDTV (progressive) and computer signals.

Setting HDMI [HDMI SETTINGS]
Make the settings for video level and audio level when connecting HDMI equipment such as a DVD player. 

VIDEO LEVEL	��������� Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NOR-
MAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image 
contrast and increase detail in the dark areas.

AUDIO SELECT (not available on M420XV)
	������������������������������ Select [HDMI] to switch the HDMI IN digital audio signal and select [COMPUTER 2] to switch the COMPUTER 

2 input audio signal.

Enabling Key Sound and Error Sound [BEEP] (not available on M420XV)
This feature turns on or off the button sound or alarm when an error occurs or the following operations are per-
formed.

- Displaying the main menu 

- Switching sources

- Resetting data by using [RESET]

- Pressing POWER ON or POWER OFF button
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[OPTIONS(2)]

Selecting Power-saving in [STANDBY MODE]
The projector has two standby modes: [NORMAL] and [POWER-SAVING].
The POWER-SAVING mode is the mode that allows you to put the projector in the power-saving condition which 
consumes less power than the NORMAL mode. The projector is preset for NORMAL mode at the factory.

NORMAL	���������������� Power indicator: Orange light/STATUS indicator: Green light
POWER-SAVING	���� Power indicator: Red light/STATUS indicator: Off

The following connectors, buttons or functions will not work during this mode.
- �MONITOR OUT (COMP. 1) connector, and AUDIO OUT connector (The M420XV does not come with the 

AUDIO OUT connector.)
- LAN and Mail Alert functions
- Buttons other than POWER button on the cabinet
- Buttons other than POWER ON button on the remote control
- Virtual Remote Tool, USB Display fucntion

NOTE: 
•	 When [CONTROL PANEL LOCK], [CONTROL ID], or [AUTO POWER ON(COMP1)] is turned on, the [STANDBY MODE] setting is 

not available.
•	 Even when [POWER-SAVING] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
•	 The power consumption in the standby mode will not be included in calculating CO2 emission reduction.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Enabling Auto Power On [AUTO POWER ON(AC)]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the 
need to always use the POWER button on the remote control or projector cabinet.
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Turning On the Projector By Applying Computer Signal [AUTO POWER ON(COMP1)]
When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER1 
IN input will power on the projector and simultaneously project the computer’s image.
This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet 
to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE: 
•	 Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in com-

bination of the AUTO POWER OFF function.
•	 This function will not be available under the following conditions:

-	 when a component signal is applied to the COMPUTER1 IN connector
-	 when a Sync on Green RGB signal or composite sync signal is applied

•	 To enable the AUTO POWER ON (COMP1) after turning off the projector, wait 3 seconds and input a computer signal.
	 If a computer signal is still present when the projector is turned off, the AUTO POWER ON (COMP1) will not work and the projector 

remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5min., 10min., 
20min., 30min.) if there is no signal received by any input or if no operation is performed.

Selecting Default Source [DEFAULT SOURCE SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST	���������������������� Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO	��������������������� Searches for an active source in order of COMPUTER1 → COMPUTER2 → HDMI → VIDEO → S-VIDEO → 

VIEWER → USB DISPLAY → COMPUTER1 and displays the first found source.
COMPUTER1	��������� Displays the computer signal from the COMPUTER 1 IN connector every time the projector is turned on.
COMPUTER2	��������� Displays the computer signal from the COMPUTER 2 IN connector every time the projector is turned on.
HDMI	��������������������� Displays the digital source from the HDMI IN connector every time the projector is turned on. 
VIDEO	�������������������� Displays the Video source from the VIDEO IN connector every time the projector is turned on.
S-VIDEO	���������������� Displays the Video source from the S-VIDEO IN connector every time the projector is turned on.
VIEWER	����������������� Displays slides or plays back movie files from the USB memory device every time the projector is turned 

on.
NETWORK	������������� Displays a signal from LAN port (RJ-45) or the USB Wireless LAN Unit.
USB DISPLAY	�������� Displays the computer signal from the USB (PC) port every time the projector is turned on.
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Setting up the Projector for a Wired LAN Connection [WIRED LAN]

Important
•	 Consult with your network administrator about these settings.
•	 When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projec-

tor. (→ page 110)

TIP: The network settings you make will not be affected even when [RESET] is done from the menu.

[WIRED LAN] [DISABLE] Wired LAN connection will be turned off.

[ENABLE] Wired LAN connection will be turned on.

[SETTINGS] [DHCP] ON	�������������������������� IP address, subnet mask, and gateway will 
be automatically assigned to the projector 
from your DHCP server.

OFF	������������������������� Specify IP address, subnet mask, and gate-
way assigned by your network administra-
tor.

[IP ADDRESS] Set your IP address of the network connected to the 
projector.

[SUBNET MASK] Set your subnet mask number of the network connected 
to the projector.

[GATEWAY] Set the default gateway of the network connected to the 
projector.

[AUTO DNS] ON	��������������������������DHCP server will automatically assign IP 
address of DNS server connected to the 
projector.

OFF	������������������������� Set your IP address of DNS server connected 
to the projector.
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Setting up the Projector for a Wireless LAN Connection (with the optional USB Wireless 
LAN Unit equipped) [WIRELESS LAN]

Important
•	 Consult with your network administrator about these settings.
•	 When using a wireless LAN connection, attach the optional USB Wireless LAN to the projector. (→ page 111)

[PROFILE] [DISABLE] Wireless LAN connection will be turned off

[EASY CONNECTION] Select [EASY CONNECTION] to execute a wireless LAN 
easily using Image Express Utility Lite on the supplied 
NEC Projector CD-ROM.

[PROFILE 1] Up to two settings for the USB wireless LAN unit can be 
stored in memory of the projector. (→ page 47)
To recall the settings from memory, select [PROFILE 1] or 
[PROFILE 2] from [PROFILE].

[PROFILE 2]

[RECONNECT] Retry to connect the projector to a network. Try this if you have changed [PROFILE].

NOTE: After selecting [EASY CONNECTION] from [PROFILE], you cannot make settings to [DHCP], [IP ADDRESS], [SUBNET MASK], 
[GATEWAY], and [AUTO DNS] except [CHANNEL]. 
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Hints on How to Set Up LAN Connection

To set up the projector for a LAN connection:
Access the HTTP server function to display the web browser (→ page 44) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for the USB Wireless LAN Unit.
Next select [SETTINGS] for your selected profile, and set [ENABLE] or [DISABLE] for [DHCP], [IP ADDRESS], 
[SUBNET MASK], and [GATEWAY]. Last click [SAVE]. To reflect changes, click the [SETTING] tab and then click 
[APPLY]. (→ page 47)

To recall LAN settings stored in the profile number:
Use [PROFILE 1] or [PROFILE 2] set on the HTTP server, from the projector’ menu, select [SETUP] → [WIRELESS 
LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2]. Last select [OK] and press the ENTER button. (→ page 92)

To connect a DHCP server:
From the projector menu, select [SETUP] → [WIRED LAN] → [SETTINGS] → [DHCP] → [ON] and press the ENTER 
button. To specify IP address without using the DHCP server, use the HTTP server function. (→ page 44)

To set only for wireless LAN (NETWORK TYPE and WEP/WPA):
Access the HTTP server function to display the web browser (→ page 44) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Make necessary settings for [SETTINGS] and click [SAVE].
From the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2]. 

To select an SSID:
Access the HTTP server function to display the web browser (→ page 44) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [CONNECTION] → [SITE SURVEY] and select the ID.
If you do not use [SITE SURVEY], type the SSID in [CONNECTION] and select [INFRASTRUCTURE] or [AD HOC]. 
(→ page 47)

To receive lamp replacement time or error messages via e-mail:
Access the HTTP server function to display the web browser (→ page 44) and select [NETWORK SETTINGS] → 
[ALERT MAIL], and set [SENDER’S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT’S ADDRESS]. Last, 
click [SAVE]. (→ page 49)

To execute [EASY CONNECTION] using Image Express Utility Lite:
The [EASY CONNECTION] is a mode that can abbreviate the troublesome LAN settings when using the Image 
Express Utility Lite and connecting the PC and projector via a wireless LAN.
The Image Express Utility Lite is contained on the supplied NEC Projector CD-ROM. 

To use [EASY CONNECTION], access the HTTP server function to display the web browser (→ page 44) and select 
[NETWORK SETTINGS] → [SETTINGS] → [WIRELESS LAN] → [EASY CONNECTION]. Next select [SETTINGS] 
→ [CHANNEL]. Last click [SAVE].
From the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [EASY CONNECTION]. 
NOTE: The [EASY CONNECTION] function is available on Windows 7, Windows Vista or Windows XP SP3.
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7 Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has six pages. The information included is as 
follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP LIFE REMAINING] (%)*
[LAMP HOURS USED] (H)
[FILTER HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)

*	 The progress indicator shows the percentage of remaining bulb life.

	 The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE 
REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.

	 If the remaining lamp time reaches 0 hours, the projector will not turn on.

•	 The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when 
the projector is turned on and when the POWER button on the projector or the remote control is pressed.

	 To dismiss this message, press any button on the projector or the remote control.

Lamp life(H)

Replacement lamp ModelECO MODE
NORMAL

(OFF or AUTO ECO)
ECO

(ECO1 or ECO2*)
3000 3500 NP17LP M420X, M420XV, M350XS, M300WS
4000 5000 NP16LP M350X, M300W, M300XS, M260WS

5000 6000 NP15LP
M300X, M260X, M230X, M260W, 
M260XS

* [ECO2] is available on M300X, M260X, and M260XS only. 

•	 [TOTAL CARBON SAVINGS]

	 This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving cal-
culation is based on the OECD (2008 Edition). (→ page 31)
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[SOURCE]

[SOURCE NAME]	 	 [SOURCE INDEX]
[HORIZONTAL FREQUENCY]	 [VERTICAL FREQUENCY]
[SIGNAL TYPE]	 	 	 [VIDEO TYPE]
[SYNC TYPE]	 	 	 [SYNC POLARITY]
[SCAN TYPE]

[WIRED LAN]

[IP ADDRESS]	 [SUBNET MASK]
[GATEWAY]	 [MAC ADDRESS]

[WIRELESS LAN]

[IP ADDRESS]	 [SUBNET MASK]
[GATEWAY]	 [MAC ADDRESS]
[SSID]	 	 [NETWORK TYPE]
[WEP/WPA]	 [CHANNEL]
[SIGNAL LEVEL]
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[VERSION]

[FIRMWARE] Version
[DATA] Version

[OTHERS]

[PROJECTOR NAME]
[MODEL NO.]
[SERIAL NUMBER]
[LAN UNIT TYPE]
[CONTROL ID] (when [CONTROL ID] is set)
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8 Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except 
the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. 
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], 
[ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SECURITY], [COMMUNI-
CATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS 
USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and [WIRELESS LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the 
lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the 
HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.

Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

The [OFF] item is selected for [FILTER MESSAGE] at the time of shipment. When [OFF] is selected, you do not need 
to clear the filter usage hour.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
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32

1

This section describes how to set up your projector and how to connect video and audio sources.
Your projector is simple to set up and use. But before you get started, you must first:

z	 Set up a screen and the projector.

x	 Connect your computer or video equipment 
to the projector.

	 (→ page 104, 106, 107, 108, 109, 110, 111)

c	 Connec t  the  supp l ied  power  cord . 
(→ page 15)

NOTE: 
•	 Ensure that the power cord and any other cables are 

disconnected before moving the projector. When 
moving the projector or when it is not in use, cover 
the lens with the sliding lens cover.

•	 An optional cable cover (NP01CV) is available for 
the M420X, M420XV, M350XS, M300XS, M260XS, 
M300WS, and M260WS. Refer to page 114 for at-
taching the cable cover.

 Setting Up the Screen and the Projector
Selecting a Location

[M350X/M300X/M260X/M230X]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 
approximately 25" (0.64 m) measured diagonally when the projector is roughly 35 inches (0.9 m) from the wall or 
screen. The largest the image can be is 300" (7.6 m) when the projector is about 435 inches (11.0 m) from the wall 
or screen.

300"
240"

Distance (Unit: m
/inch)

Lens center

Screen Size

Screen Size (Unit: cm/inch)

200"180"150"

120"
100"

80"

11.0/435"

8.8/348"

6.6/260"

5.5/216"

4.4/173"

3.6/144"

2.9/115"
2.2/86"

1.4/57"

40"

7.3/289"

60"

30"25"

1.1/
42"

0.9/
35"

609.6(W)�457.2(H) / 240(W)�180(H)

487.7(W)�365.8(H) / 192(W)�144(H)

406.4(W)�304.8(H) / 160(W)�120(H)

304.8(W)�228.6(H) / 120(W)�90(H)

365.8(W)�274.3(H) / 144(W)�108(H)

243.8(W)�182.9(H) / 96(W)�72(H)

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

81.3(W)�61.0(H) / 32(W)�24(H)

61.0(W)�45.7(H) / 24(W)�18(H)

50.8(W)�38.1(H) / 20(W)�15(H)

TIP:
•	 The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
•	 For more details on throw distance, see page 101.

To the wall outlet.
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[M420X/M420XV]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 
approximately 25" (0.64 m) measured diagonally when the projector is roughly 34 inches (0.9 m) from the wall or 
screen. The largest the image can be is 300" (7.6 m) when the projector is about 434 inches (11.0 m) from the wall 
or screen.

300"
240"

Distance (Unit: m
/inch)

Lens center

Screen Size

Screen Size (Unit: cm/inch)

200"180"150"

120"
100"

80"

11.0/434"
8.8/347"

6.6/260"

5.5/216"

4.4/172"

3.6/143"
2.9/114"

2.2/85"

1.4/56"

40"

7.3/289"

60"

30"25"

1.0/
42"

0.9/
34"

646.2(W)�403.9(H) / 254(W)�159(H)

516.9(W)�323.1(H) / 204(W)�127(H)

430.8(W)�269.2(H) / 170(W)�106(H)

323.1(W)�201.9(H) / 127(W)�79(H)

387.7(W)�242.3(H) / 153(W)�95(H)

258.5(W)�161.5(H) / 102(W)�64(H)

215.4(W)�134.6(H) / 85(W)�53(H)

172.3(W)�107.7(H) / 68(W)�42(H)

129.2(W)�80.8(H) / 51(W)�32(H)

86.2(W)�53.8(H) / 34(W)�21(H)

64.6(W)�40.4(H) / 25(W)�16(H)

53.8(W)�33.7(H) / 21(W)�13(H)

TIP:
•	 The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
•	 For more details on throw distance, see page 101.

[M300W/M260W]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 
approximately 25" (0.64 m) measured diagonally when the projector is roughly 37 inches (0.9 m) from the wall or 
screen. The largest the image can be is 300" (7.6 m) when the projector is about 459 inches (11.7 m) from the wall 
or screen.

300"
240"

Distance (Unit: m
/inch)

Lens center

Screen Size

Screen Size (Unit: cm/inch)

200"180"150"

120"
100"

80"

11.7/459"

9.3/367"

7.0/275"

5.8/229"

4.6/183"

3.9/152"

3.1/121"
2.3/90"

1.5/60"

40"

7.8/306"

60"

30"25"

1.1/
45"

0.9/
37"

646.2(W)�403.9(H) / 254(W)�159(H)

516.9(W)�323.1(H) / 204(W)�127(H)

430.8(W)�269.2(H) / 170(W)�106(H)

323.1(W)�201.9(H) / 127(W)�79(H)

387.7(W)�242.3(H) / 153(W)�95(H)

258.5(W)�161.5(H) / 102(W)�64(H)

215.4(W)�134.6(H) / 85(W)�53(H)

172.3(W)�107.7(H) / 68(W)�42(H)

129.2(W)�80.8(H) / 51(W)�32(H)

86.2(W)�53.8(H) / 34(W)�21(H)

64.6(W)�40.4(H) / 25(W)�16(H)

53.8(W)�33.7(H) / 21(W)�13(H)

TIP:
•	 The distances are indicated by intermediate values between tele and wide. Use as a rule of thumb.
•	 For more details on throw distance, see page 102.
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[M350XS/M300XS/M260XS]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is ap-
proximately 60" (1.52 m) measured diagonally when the projector is 23 inches (0.57 m) from the wall or screen. The 
largest the image can be is 110" (2.8 m) when the projector is about 43 inches (1.1 m) from the wall or screen.

Distance (Unit: m
/inch)

Lens center

Screen Size
110"100"

90"
84"

80"

1.10/43"

1.00/39"

0.89/35"

0.83/33"
0.78/31"

0.70/28"

0.57/23"

60"

72"

203.2(W)�152.4(H) / 80(W)�60(H)

223.5(W)�167.6(H) / 88(W)�66(H)

182.9(W)�137.2(H) / 72(W)�54(H)

170.7(W)�128.0(H) / 67(W)�50(H)

162.6(W)�121.9(H) / 64(W)�48(H)

146.3(W)�109.7(H) / 58(W)�43(H)

121.9(W)�91.4(H) / 48(W)�36(H)

Screen Size (Unit: cm/inch)

TIP:
•	 Digital Zoom can result in a blurry image due to the electronic zoom.
•	 For more details on throw distance, see page 102.

[M300WS/M260WS]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 
approximately 56" (1.4 m) measured diagonally when the projector is 22 inches (0.57 m) from the wall or screen. The 
largest the image can be is 104" (2.6 m) when the projector is about 43 inches (1.1 m) from the wall or screen.

Distance (Unit: m
/inch)

Lens center

Screen Size
104"100"

90"
80"

70"

1.10/43"

1.06/42"

0.95/37"

0.84/33"
0.72/28"

0.61/24"

0.57/22"

56.2"

60"

215.4(W)�134.6(H) / 85(W)�53(H)

224.0(W)�140.0(H) / 88(W)�55(H)

193.9(W)�121.2(H) / 76(W)�48(H)

172.3(W)�107.7(H) / 68(W)�42(H)

150.8(W)�94.2(H) / 59(W)�37(H)

129.2(W)�80.8(H) / 51(W)�32(H)

121.1(W)�75.7(H) / 48(W)�30(H)

Screen Size (Unit: cm/inch)

TIP:
•	 Digital Zoom can result in a blurry image due to the electronic zoom.
•	 For more details on throw distance, see page 102.
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C

α

B

D

Throw Distance and Screen Size
The following shows the proper relative positions of the projector and screen. Refer to the table to determine the 
position of installation.

Distance Chart

B =	 Vertical distance between lens center and 
screen center

C =	 Throw distance
D =	 Vertical distance between lens center and 

screen bottom (top of screen for ceiling ap-
plication)

α =	 Throw angle

NOTE: The values in the tables are design values and 
may vary.

[M350X/M300X/M260X/M230X]
Screen Size B C D

α
Diagonal Width Height wide tele wide tele

inch mm inch mm inch mm inch mm inch mm - inch mm inch mm degree - degree
25 635 20 508 15 381 5 131 26 649 - 44 1107 -2 -60 11.4 - 6.7 
30 762 24 610 18 457 6 157 31 788 - 53 1337 -3 -71 11.3 - 6.7 
40 1016 32 813 24 610 8 210 42 1066 - 71 1798 -4 -95 11.1 - 6.6 
60 1524 48 1219 36 914 12 314 64 1622 - 107 2720 -6 -143 11.0 - 6.6 
72 1829 58 1463 43 1097 15 377 77 1956 - 129 3273 -7 -171 10.9 - 6.6 
80 2032 64 1626 48 1219 17 419 86 2178 - 143 3642 -8 -191 10.9 - 6.6 
84 2134 67 1707 50 1280 17 440 90 2289 - 151 3827 -8 -200 10.9 - 6.6 
90 2286 72 1829 54 1372 19 471 97 2456 - 162 4103 -8 -214 10.9 - 6.6 

100 2540 80 2032 60 1524 21 524 108 2734 - 180 4564 -9 -238 10.8 - 6.5 
120 3048 96 2438 72 1829 25 629 130 3290 - 216 5486 -11 -286 10.8 - 6.5 
150 3810 120 3048 90 2286 31 786 162 4124 - 270 6869 -14 -357 10.8 - 6.5 
180 4572 144 3658 108 2743 37 943 195 4958 - 325 8252 -17 -429 10.8 - 6.5 
200 5080 160 4064 120 3048 41 1048 217 5514 - 361 9174 -19 -476 10.8 - 6.5 
210 5334 168 4267 126 3200 43 1100 228 5792 - 379 9635 -20 -500 10.8 - 6.5 
240 6096 192 4877 144 3658 50 1257 261 6626 - 434 11018 -23 -572 10.7 - 6.5 
270 6858 216 5486 162 4115 56 1414 294 7460 - 488 12401 -25 -643 10.7 - 6.5 
300 7620 240 6096 180 4572 62 1572 327 8294 - 543 13784 -28 -714 10.7 - 6.5 

[M420X/M420XV]
Screen Size B C D

α
Diagonal Width Height wide tele wide tele

inch mm inch mm inch mm inch mm inch mm - inch mm inch mm degree - degree
25 635 20 508 15 381 5 131 25 636 - 43 1094 -2 -60 11.6 - 6.8 
30 762 24 610 18 457 6 157 31 775 - 52 1324 -3 -71 11.5 - 6.8 
40 1016 32 813 24 610 8 210 41 1053 - 70 1785 -4 -95 11.3 - 6.7 
60 1524 48 1219 36 914 12 314 63 1609 - 107 2707 -6 -143 11.1 - 6.6 
72 1829 58 1463 43 1097 15 377 76 1943 - 128 3261 -7 -171 11.0 - 6.6 
80 2032 64 1626 48 1219 17 419 85 2165 - 143 3629 -8 -191 11.0 - 6.6 
84 2134 67 1707 50 1280 17 440 90 2277 - 150 3814 -8 -200 10.9 - 6.6 
90 2286 72 1829 54 1372 19 471 96 2443 - 161 4090 -8 -214 10.9 - 6.6 

100 2540 80 2032 60 1524 21 524 107 2721 - 179 4551 -9 -238 10.9 - 6.6 
120 3048 96 2438 72 1829 25 629 129 3277 - 215 5473 -11 -286 10.9 - 6.6 
150 3810 120 3048 90 2286 31 786 162 4111 - 270 6856 -14 -357 10.8 - 6.5 
180 4572 144 3658 108 2743 37 943 195 4945 - 324 8239 -17 -429 10.8 - 6.5 
200 5080 160 4064 120 3048 41 1048 217 5501 - 361 9161 -19 -476 10.8 - 6.5 
210 5334 168 4267 126 3200 43 1100 228 5779 - 379 9622 -20 -500 10.8 - 6.5 
240 6096 192 4877 144 3658 50 1257 260 6613 - 433 11005 -23 -572 10.8 - 6.5 
270 6858 216 5486 162 4115 56 1414 293 7447 - 488 12388 -25 -643 10.8 - 6.5 
300 7620 240 6096 180 4572 62 1572 326 8281 - 542 13771 -28 -714 10.7 - 6.5 

Screen center

Lens center

Screen bottom
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[M300W/M260W]
Screen Size B C D

α
Diagonal Width Height wide tele wide tele

inch mm inch mm inch mm inch mm inch mm - inch mm inch mm degree - degree
25 635 21 538 13 337 5 139 27 687 - 46 1172 -1 -29 11.4 - 6.8 
30 762 25 646 16 404 7 167 33 833 - 56 1415 -1 -35 11.3 - 6.7 
40 1016 34 862 21 538 9 222 44 1126 - 75 1902 -2 -47 11.2 - 6.7 
60 1524 51 1292 32 808 13 333 67 1712 - 113 2876 -3 -71 11.0 - 6.6 
72 1829 61 1551 38 969 16 400 81 2064 - 136 3461 -3 -85 11.0 - 6.6 
80 2032 68 1723 42 1077 17 444 90 2298 - 152 3850 -4 -94 10.9 - 6.6 
84 2134 71 1809 45 1131 18 466 95 2415 - 159 4045 -4 -99 10.9 - 6.6 
90 2286 76 1939 48 1212 20 500 102 2591 - 171 4337 -4 -106 10.9 - 6.6 

100 2540 85 2154 53 1346 22 555 114 2884 - 190 4824 -5 -118 10.9 - 6.6 
120 3048 102 2585 64 1615 26 666 137 3470 - 228 5798 -6 -141 10.9 - 6.6 
150 3810 127 3231 79 2019 33 833 171 4349 - 286 7259 -7 -177 10.8 - 6.5 
180 4572 153 3877 95 2423 39 1000 206 5228 - 343 8720 -8 -212 10.8 - 6.5 
200 5080 170 4308 106 2692 44 1111 229 5814 - 382 9694 -9 -236 10.8 - 6.5 
210 5334 178 4523 111 2827 46 1166 240 6107 - 401 10181 -10 -247 10.8 - 6.5 
240 6096 204 5169 127 3231 52 1333 275 6986 - 458 11642 -11 -283 10.8 - 6.5 
270 6858 229 5816 143 3635 59 1499 310 7865 - 516 13103 -13 -318 10.8 - 6.5 
300 7620 254 6462 159 4039 66 1666 344 8744 - 573 14564 -14 -353 10.8 - 6.5 

[M350XS/M300XS/M260XS]
Screen Size B C D

α
Diagonal Width Height wide wide

inch mm inch mm inch mm inch mm inch mm inch mm degree
60 1524 48 1219 36 914 18 457 23 573 0 0 38.6
72 1829 58 1463 43 1097 22 549 28 700 0 0 38.1
80 2032 64 1626 48 1219 24 610 31 784 0 0 37.9
84 2134 67 1707 50 1280 25 640 33 827 0 0 37.7
90 2286 72 1829 54 1372 27 686 35 890 0 0 37.6

100 2540 80 2032 60 1524 30 762 39 996 0 0 37.4
110 2794 88 2235 66 1676 33 838 43 1101 0 0 37.3

[M300WS/M260WS]
Screen Size B C D

α
Diagonal Width Height wide wide

inch mm inch mm inch mm inch mm inch mm inch mm degree
56.2 1427 48 1211 30 757 18 454 22 569 3 76 38.6

60 1524 51 1292 32 808 19 485 24 611 3 81 38.4
70 1778 59 1508 37 942 22 565 28 723 4 94 38.0
80 2032 68 1723 42 1077 25 646 33 835 4 108 37.7
90 2286 76 1939 48 1212 29 727 37 947 5 121 37.5

100 2540 85 2154 53 1346 32 808 42 1059 5 135 37.3
104 2642 88 2240 55 1400 33 840 43 1104 6 140 37.3
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WARNING
*	 Installing your projector on the ceiling must be done 

by a qualified technician. Contact your NEC dealer for 
more information.

*	 Do not attempt to install the projector yourself.
•	 Only use your projector on a solid, level surface. If the 

projector falls to the ground, you can be injured and 
the projector severely damaged.

•	 Do not use the projector where temperatures vary 
greatly. The projector must be used at temperatures 
between 41°F (5°C) and 104°F (40°C) (Eco mode se-
lected automatically at 95°F to 104°F/35°C to 40°C).

•	 Do not expose the projector to moisture, dust, or 
smoke. This will harm the screen image.

•	 Ensure that you have adequate ventilation around your 
projector so heat can dissipate. Do not cover the vents 
on the side or the front of the projector.

Reflecting the Image
Using a mirror to reflect your projector’s image enables 
you to enjoy a much larger image when a smaller space 
is required. Contact your NEC dealer if you need a mirror 
system. If you’re using a mirror system and your image 
is inverted, use the MENU and  buttons on your 
projector cabinet or your remote control to correct the 
orientation. (→ page 85)
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COMPUTER 1 IN COMPUTER 1 INHDMI INUSB(PC)AUDIO IN

HDMI IN

USB(PC)

Computer cable (VGA) (supplied)
To mini D-Sub 15-pin connector on the projector. It is 
recommended that you use a commercially avail-
able distribution amplifier if connecting a signal cable 
longer than the cable supplied.

A commercially available 
USB cable 
(compatible with USB 2.0 
specifications)

NOTE: For Macintosh, use a commercially available pin adapter (not 
supplied) to connect to your Mac’s video port.

Stereo mini-plug 
audio cable (not 
supplied)

 Making Connections
NOTE: When using with a notebook PC, be sure to connect the projector and notebook PC while the projector is in standby mode 
and before turning on the power to the notebook PC.
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power manage-

ment software.

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector.
When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

Connecting Your Computer

NOTE: Signals supported by Plug & Play (DDC2)

INPUT
COMPUTER 1 IN COMPUTER 2 IN HDMI

analog analog digital
Yes Yes Yes

HDMI cable (not supplied)
Use High Speed HDMI® 
Cable.

NOTE: The M420XV does not come with the 
AUDIO IN connector (stereo mini jack).

M420XV
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•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER 1 (COMPUTER 1)

COMPUTER 2 IN  COMPUTER 2 (COMPUTER 2)

HDMI IN  HDMI HDMI

USB (PC)  USB DISPLAY (USB DISPLAY)

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back via a commercially available scan 
converter. 
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
*	 When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
	 Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.

NOTE: When Viewing a DVI Digital Signal
•	 Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 stan-

dard. The cable should be within 197"/5 m long.
•	 Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
•	 To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC.
	 Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, 

restart your PC.
•	 Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub connector may 

result in no picture being displayed from the digital output of the graphics card.
•	 Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then 

reconnected, an image may not be correctly displayed. Should this happen, restart your PC.

 

NOTE: When [VIEWER], [NETWORK], or [USB DISPLAY] is selected for [SOURCE], sound from the COMPUTER 2 AUDIO IN mini 
jack will be output through the speaker.
 
 

NOTE: HDMI input signal
Disconnecting and connecting the HDMI cable may result in no picture being displayed from the HDMI equipment while the projec-
tor is running. 
Should this happen, select the HDMI input again. 
<Two ways to select the HDMI input> 
•	 Press the HDMI button on the remote control. 
•	 Press the MENU button on the projector cabinet, then select [HDMI] from [SOURCE]. 
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Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer 
analog image you’re projecting.

NOTE:
•	 Daisy chain connection is not possible.
•	 When audio equipment is connected, the projector speaker is disabled.
•	 The M420XV does not come with the AUDIO OUT connector (stereo mini jack).

AUDIO
IN PHONE

MONITOR OUT (COMP. 1)

AUDIO OUT

MONITOR OUT (COMP. 1)

Com-
puter cable 
(VGA) 
(supplied)

Stereo mini-plug 
audio cable (not 
supplied)

Computer cable (VGA) 
(not supplied)

M420XV
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Connecting Your DVD Player or Other AV Equipment
Connecting Video/S-Video Input

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

VIDEO IN  VIDEO (VIDEO)

S-VIDEO IN  S-VIDEO (S-VIDEO)

NOTE: 
•	 The AUDIO IN L and R jacks (RCA) are shared between the Video and S-Video inputs.
•	 The M420XV does not come with the AUDIO IN connectors (RCA).

NOTE: Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

NOTE: An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via 
a scan converter.

AUDIO OUTVIDEO OUT
S-VIDEO VIDEO L R AUDIO IN

L R

S-VIDEO INVIDEO INS-VIDEO INVIDEO IN

AUDIO IN

Audio cable (not supplied)
S-Video cable (not supplied)

Video cable (not supplied)

Audio equipment

Audio cable (not supplied)

M420XV
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Connecting Component Input

	 A component signal will be automatically displayed. If not, from the menu, select [SETUP] → [OPTIONS(1)] → 
[SIGNAL SELECT] → [COMPUTER1] or [COMPUTER2], and then place a check mark in the Component radio 
button.

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER 1 (COMPUTER 1)

COMPUTER 2 IN  COMPUTER 2 (COMPUTER 2)

NOTE: Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.

NOTE: The M420XV does not come with the AUDIO IN connector.

AUDIO	IN
L R

AUDIO	OUT

L R

Component

Y Cb Cr

AUDIO	IN
COMPUTER	1	INCOMPUTER	1	IN

Audio cable (not supplied)

15-pin - to - RCA (female) × 3 
cable adapter (ADP-CV1E)

Stereo mini plug - to - RCA 
audio cable (not supplied)

Component video 
RCA × 3 cable (not 
supplied)

DVD player

Audio Equipment

M420XV
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AUDIO IN
L RAUDIO OUT

L R

VIDEO OUTHDMI OUT
S-VIDEO VIDEO

HDMI Output

HDMIHDMI

HDMI

HDMI IN HDMI IN 

Connecting HDMI Input
You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the 
HDMI IN connector of your projector.
NOTE: The HDMI IN connector supports Plug & Play (DDC2B).

Audio cable (not supplied)

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI IN  HDMI HDMI

TIP: For users of audio video equipment with an HDMI connector:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”.
This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

•	 When connecting the HDMI IN connector of the projector to the DVD player, the projector’s video level can be 
made settings in accordance with the DVD player’s video level. In the menu select [HDMI SETTINGS] → [VIDEO 
LEVEL] and make necessary settings.

•	 If the HDMI input sound cannot be heard, in the menu select [HDMI SETTINGS] → [AUDIO SELECT] → [HDMI]. 
Note that the [AUDIO SELECT] is not available on M420XV.

M420XV
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Connecting to a Wired LAN
The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. 
To use a LAN connection, you are required to set the LAN on the projector menu. Select [SETUP] → [WIRED LAN]. 
(→ page 91).

Example of LAN connection
Example of wired LAN connection

LAN

Server

Hub

LAN cable (not supplied)

NOTE: Use a Category 5 or higher LAN 
cable.
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Connecting to a Wireless LAN (Optional: NP02LM series)
The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are 
required to assign an IP address to the projector.

Important:
•	 If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is 

prohibited, remove the USB Wireless LAN Unit from the projector.

•	 Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.
•	 Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Flow of Setting Wireless LAN
Step 1:	 Attach the USB Wireless LAN Unit to the projector.

Step 2:	 Connect the computer to the projector via wired LAN. (→ page 110)

	 Use the computer’s browser to display the projector’s HTTP server. (→ page 44)

Step 3:	 Use an HTTP server to set the wireless LAN. (→ page 47)

	 Access the HTTP server function to set [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS] → 
[EASY CONNECTION] , [PROFILE1] or [PROFILE2].

NOTE: 
•	 To use the HTTP server function, the projector must be connected to a network.
	 First use the wired LAN to connect the projector to a network and then use the HTTP server to set the wireless LAN.
•	 After setting the wireless LAN by using the HTTP server, set [NETWORK SETTINGS] → [SETTINGS] → [WIRED] → [DISABLE]

When switching to set on the projector after connecting to the wireless LAN:
Use the menu to set the wireless LAN connection for the projector. 
(→ page 92)
Select [DISABLE], [EASY CONNECTION] , [PROFILE1] or [PROFILE2] you set from the HTTP server.

Attaching the USB Wireless LAN Unit

NOTE:
•	 The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted 

in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB 
port may break.

•	 Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge 
the static electricity from your body.

•	 Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector 
malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect 
the power cord, and then connect it again.

•	 Do not insert other USB devices into the USB Wireless LAN unit port. Do not insert the USB Wireless LAN unit into the USB (PC) 
port (Type B).
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Prepare a Phillips screw driver beforehand.

1.	 Press the POWER button to turn off the projector and set it 
into standby condition, and disconnect the power cord.

2.	 Remove the USB (LAN) port cover.

	 Loosen the screw securing the port cover.

	 • The screw is not removable. 

3.	 Slowly insert the USB Wireless LAN Unit into the USB (LAN) 
port.

	 Remove the cap from the USB Wireless LAN Unit, and then insert 
it with the surface (side of indicator) facing outward. Keep the cap 
for later use.

NOTE: Do not force to insert the USB Wireless LAN Unit.

4.	 Put the USB (LAN) port cover back into place.

	 Insert the catch of the USB (LAN) port cover into the groove of the 
projector cabinet, and then tighten the screw to secure the port 
cover.

To remove the USB Wireless LAN Unit, disconnect the power cord 
and use the above procedure.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that Wireless 

LAN Unit is working. If the USB Wireless LAN Unit is incorrectly attached, 
the blue LED will not flash.

•	 Do not press the button on the USB Wireless LAN Unit. The button will not 
work with this model.

 

WIRELESS

WIRELESS

WIRELESS

WIRELESS

[M420X/M420XV/M350XS/M300XS/M260XS/
M300WS/M260WS]
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Example of wireless LAN connection
(Network Type → Infrastructure)

 PC with wireless 
LAN card inserted

PC with built-in wireless 
LAN function

Wired LAN

Wireless access point

USB Wireless LAN Unit

To enable direct communication (i.e., peer-to-peer) between personal computers and projectors, you need to 
select the Ad Hoc mode.

Use the HTTP server function to make the settings. (→ page 44)

PC with wireless 
LAN card inserted

PC with built-in wireless 
LAN function

Use the HTTP server function to make the settings. (→ page 44)

Example of wireless LAN connection (Network Type → Ad Hoc)

USB Wireless LAN Unit
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Attaching the Optional Cable Cover (NP01CV)
An optional cable cover (NP01CV) is available for hiding cables.
The NP01CV cable cover is designed for use with the M420X, M420XV, M350XS, M300XS, M260XS, M300WS, and 
M260WS.

 CAUTION:
•	 Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come 

off and fall, resulting in injury or damage to the cable cover.
•	 Do not put bundled cables in the cable cover. Failure to do so may damage the power cord, resulting a fire.

Attaching the cable cover
Attach the cable cover after installing the projector on the ceiling and connecting cables.
Tool needed for attaching:
•	 Phillips screwdriver (plus-head)

1.	 Align two tabs on the outside of the cable cover with grooves of the projector and push the top end.

1

2

1

Tabs

•	 At the same time two tabs on the inside of the cable cover will be engaged in the responding grooves of the 
projector. 

NOTE:
•	 Be careful not to get cables caught in between the cable cover and the projector.

2.	 Tighten the cable cover screws.

•	 Be sure to tighten the screws.

1

2

Removing the cable cover

1.	 Loosen the cable cover screws until the Phillips screwdriver goes into a freewheeling condition 

2.	 Remove the cable cover.

	 Push up the cable cover slightly and rotate it to release.



115

7. Maintenance
This section describes the simple maintenance procedures you should follow to clean the filters, the lens, the cabinet, 
and to replace the lamp and the filters.

 Cleaning the Filters
The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter 
is dirty or clogged, your projector may overheat.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is 
displayed, clean the filters. The time to clean the filters is set to [OFF] at time of shipment.
To cancel the message, press any button on the projector cabinet or the remote control.

The two-layer filter on the projector improves cooling and dust-proof capabilities compared with the conventional 
models.
The outsides (intake side) of the first and second layer filters remove dust.
To clean the filter, detach the filter unit and the filter cover.
Filter removal procedure is different depending on the model.

 CAUTION
•	 Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. 

Failure to do so can result in electric shock or burn injuries.

[M350X/M300X/M260X/M230X/M300W/M260W]
1.	 Push the button to release the filter unit and pull it out. 

2.	 Remove the filter cover.

	 The filter cover is fixed at six separate mounting points.

	 Bow the filter cover by pushing the notch slightly until it re-
leases. 

3.	 Remove the four filters and use a vacuum cleaner to 
vacuum all the dust inside.

	 Get rid of dust in the accordion filter

NOTE: 
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in filter clog-

ging.

WIRELESS

WIRELESS

Notch

Filter unit

Filter cover

Button
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4.	 Remove dust from the filter unit and the filter cover.

	 Clean both outside and inside.

5.	 Attach the four filters to the filter unit and the filter cover.

	 Filter unit: Attach two hard honeycomb filters (large and small) 
to the filter unit.

	 Filter cover: Attach two soft accordion filters (large and small) 
to the filter cover.

	 The accordion filter has slits on it. Align these slits with the 
protrusions of the filter cover.

6.	 Attach the filter cover back to the filter unit

	 Align the filter unit with the filter cover and push the six protru-
sions into place.

•	 Make sure all six mounting points are aligned properly.

7.	 Put the filter unit back to the projector cabinet.

	 Insert two catches of the tip of the filter unit into the groove of 
the cabinet, and push the button to close the filter unit.

•	 Push the filter unit until it clicks into place.

8.	 Clear the filter usage hours.

	 Plug the power cord into the wall outlet, and then turn on the 
projector.

	 From the menu, select [RESET] → [CLEAR FILTER HOURS]. 
(→ page 97)

	 The interval time to clean the filters is set to [OFF] at time of 
shipment. When using the projector as it is, you do not clear 
the filter usage 

WIRELESS

WIRELESS

ButtonGroove
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[M420X/M420XV/M350XS/M300XS/M260XS/M300WS/
M260WS]
1.	 Push up the buttons on the left and right to release the 

filter unit and pull it out.

2.	 Remove the filter unit by pulling out the tab.

3.	 Remove the four filters.

(1)	Turn the filter unit over and pull out the two soft accordion 
filters (large and small).

(2)	Push the left end of each filter and remove the hard two 
honeycomb filters (large and small).

	 • �The large filter cannot be removed by pushing on its right 
end.

4.	 Use a vacuum cleaner to vacuum all the dust inside.

	 Get rid of dust in the accordion filter

NOTE: 
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in filter clog-

ging.

Filter cover

Filter unit
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5.	 Remove dust from the filter unit and the filter cover.

	 Clean both outside and inside.

6.	 Attach the four filters to the filter unit.

(1)	Insert the left end of each hard honeycomb filter (large and 
small) first and then the right end of each hard honeycomb 
filter to the filter unit.

	 • �The large filter cannot be installed if its right end is inserted 
first.

(2)	Turn the filter unit over.

	 • �Attach the two soft accordion filters (large and small). Each 
accordion filter has a slit on it. Align the slit with each pro-
trusion of the filter unit.

7.	 Put the filter unit back to the projector cabinet.

	 Make sure that the filter unit is placed in the correct orienta-
tion.

8.	 Put the filter cover back to the projector cabinet.

	 Insert two catches of the top side of the filter cover into the 
groove of the cabinet, and push the buttons on the left and right 
to close the filter cover.

•	 Push the filter cover until it clicks into place.

9.	 Clear the filter usage hours.

	 Plug the power cord into the wall outlet, and then turn on the 
projector.

	 From the menu, select [RESET] → [CLEAR FILTER HOURS]. 
(→ page 97)

	 The interval time to clean the filters is set to [OFF] at time of 
shipment. When using the projector as it is, you do not clear 
the filter usage 
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2 Cleaning the Lens
•	 Turn off the projector before cleaning.

•	 The projector has a plastic lens. Use a commercially available plastic lens cleaner.

•	 Do not scratch or mar the lens surface as a plastic lens is easily scratched.

•	 Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

[M350X/M300X/M260X/M230X/
M300W/M260W]

[M420X/M420XV] [M350XS/M300XS/M260XS/
M300WS/M260WS]

3 Cleaning the Cabinet
Turn off the projector, and unplug the projector before cleaning.
•	 Use a dry soft cloth to wipe dust off the cabinet.

	 If heavily soiled, use a mild detergent. 

•	 Never use strong detergents or solvents such as alcohol or thinner. 

•	 When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum 
cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

•	 Clogged ventilation slits may cause a rise in  the internal temperature of the projector, resulting in malfunction.

•	 Do not scratch or hit the cabinet with your fingers or any hard objects

•	 Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product 
in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off. 
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4 Replacing the Lamp and the Filters
When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE 
LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER.” will appear 
(*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After 
replacing the lamp, be sure to clear the lamp hour meter. (→ page 97)

 CAUTION
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector 

off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

•	 Use the specified lamp for safety and performance.

•	 DO NOT REMOVE ANY SCREWS except one lamp cover screw and two lamp housing screws. You could receive 
an electric shock.

•	 Do not break the glass on the lamp housing.

	 Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause 
an unwanted shadow and poor picture quality.

•	 The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours 
after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use 
the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered 
in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC 
dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
•	 for one minute after the projector has been powered on
•	 when the  (POWER) button on the projector cabinet or the POWER OFF button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:

•	 Phillips screwdriver (plus-head)

•	 Replacement lamp:  
NP15LP (M300X/M260X/M230X/M260W/M260XS) 
NP16LP (M350X/M300W/M300XS/M260WS) 
NP17LP (M420XM/M420XV/M350XS/M300WS)

Flow of Replacing the Lamp and the Filters

Step 1.	 Replace the lamp 

Step 2.	 Replace the filters (→ page 123)

Step 3.	 Clear the lamp usage hours and the filter usage hours (→ page 97)
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2.	 Remove the lamp housing.

(1)	Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condi-
tion.

	 • The two screws are not removable.

	 • �There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this 
interlock.

(2)	Remove the lamp housing by holding it.

Interlock

To replace the lamp: 
1.	 Remove the lamp cover.

(1)	Loosen the lamp cover screw

	 • The lamp cover screw is not removable.

(2)	Push and slide the lamp cover off.

CAUTION:

Make sure that the lamp housing is cool 
enough to before removing it.

[M420X/M420XV/M350XS/
M300XS/M260XS/M300WS/
M260WS]
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This completes the lamp replacement.
Go on to the filter replacement.

NOTE: When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector 
cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
 

4.	 Reattach the lamp cover.

(1)	Slide the lamp cover back until it snaps into place.

(2)	Tighten the screw to secure the lamp cover.

	 • Be sure to tighten the screw.

3.	 Install a new lamp housing.

(1)	Insert a new lamp housing until the lamp housing is plugged into the socket. 

(2)	Push the top center of the lamp housing to secure it.

(3)	Secure it in place with the two screws.

	 • Be sure to tighten the screws.

[M420X/M420XV/M350XS/
M300XS/M260XS/M300WS/
M260WS]
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To replace the filters:
Filter removal procedure is different depending on the model. Follow the procedure suitable for your model.

Four filters are packaged with the replacement lamp.
Honeycomb filter (coarse mesh): Large and small sizes (attached to the filter unit)
Accordion filter (fine mesh): Large and small sizes (attached to the filter cover)

NOTE: 
•	 Replace all four filters at the same time.
•	 Before replacing the filters, wipe off dust and dirt from the projector cabinet. 
•	 The projector is precision equipment. Keep out dust and dirt during filter replacement.
•	 Do not wash the filters with soap and water. Soap and water will damage the filter membrane. 
•	 Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector. 

Before replacing the filters, replace the lamp. (→ page 120)

[M350X/M300X/M260X/M230X/M300W/M260W]

1.	 Push the catch to release the filter unit and pull it out.

WIRELESS

WIRELESS

2.	 Detach the filter cover from the filter unit.

	 The filter cover is fixed at six separate mounting points.

	 Bow the filter cover by pushing it slightly until it releases.

Filter cover

Notch

Filter unit
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3.	 Replace the four (4) filters

1.	 Remove the filter, and then clean the filter unit and the filter cover.

2.	 Attach new filters.

	 Filter unit: Attach two honeycomb filters (coarse mesh) to the filter unit.

	 Filter cover: Attach two accordion filters (fine mesh) to the filter cover.

	 The accordion filter has slits on it. Align these slits with the protrusions of the filter cover.

    

4.	 Attach the filter cover back to the filter unit

	 Align the filter unit with the filter cover and push the protrusions into place.

	 • �Make sure all six mounting points are aligned properly.

5.	 Put the filter unit back to the projector cabinet.

	 Insert two catches of the tip of the filter unit into the groove of the cabinet.

	 Push the filter unit until it clicks into place.

WIRELESS

WIRELESS

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.
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For standard and short-throw models
[M420X/M420XV/M350XS/M300XS/M260XS/M300WS/M260WS]

1.	 Push up the buttons on the left and right to release the filter unit and pull it out.

2.	 Remove the filter unit by pulling out the tab.

3.	 Remove the four filters.

(1)	Turn the filter unit over and pull out the two soft accordion filters (large and small).

(2)	Push the left end of each filter and remove the hard two honeycomb filters (large and small).

	 • The large filter cannot be removed by pushing on its right end.

Filter cover

Filter unit
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4.	 Remove dust from the filter unit and the filter cover.

	 Clean both outside and inside.

5.	 Attach four new filters to the filter unit.

(1)	Insert the left end of each hard honeycomb filter (large and small) first and then the right end of each hard 
honeycomb filter to the filter unit.

	 • �The large filter cannot be installed if its right end is inserted first.

(2)	Turn the filter unit over.

	 • �Attach the two soft accordion filters (large and small). Each accordion filter has a slit on it. Align the slit with 
each protrusion of the filter unit.

6.	 Put the filter unit back to the projector cabinet.

	 Make sure that the filter unit is placed in the correct orientation.

7.	 Put the filter cover back to the projector cabinet.

	 Insert two catches of the top side of the filter cover into the groove of the cabinet, and push the buttons on the left 
and right to close the filter cover.

	 Push the filter cover until it clicks into place.

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.

To clear the lamp usage hours and the filter usage hours:
1.	 Place the projector where you use it.

2.	 Plug the power cord into the wall outlet, and then turn on the projector.

3.	 Clear the lamp usage hours and the filter usage hours.

1.	 From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.

2.	 Select [CLEAR FILTER HOURS].and reset the filter usage hours. (→ page 97)
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 Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.
Indicator Messages
Power Indicator

Indicator Condition Projector Condition Note
Off The main power is off –

Blinking light Blue 0.5 sec On,
0.5 sec Off

The projector is getting ready to turn on. Wait for a moment.

2.5 sec On,
0.5 sec Off

Off Timer is enabled. –

Steady light Blue The projector is turned on. –
Orange [NORMAL] is selected for [STANDBY MODE] –
Red [POWER-SAVING] is selected for [STANDBY 

MODE]
–

Status Indicator

Indicator Condition Projector Condition Note

Off Normal or Standby ([POWER-SAVING] for 
[STANDBY MODE]) –

Blinking light Red 1 cycle (0.5 sec 
On, 2.5 sec Off)

Lamp cover error or lamp housing error Replace the lamp cover or lamp housing correctly.

2 cycle (0.5 sec 
On, 0.5 sec Off)

Temperature error The projector is overheated. Move the projector to 
a cooler location.

3 cycle (0.5 sec 
On, 0.5 sec Off)

Power error Power unit is not working properly. Contact your 
dealer.

4 cycle (0.5 sec 
On, 0.5 sec Off)

Fan error Fans will not work correctly.

6 cycle (0.5 sec 
On, 0.5 sec Off)

Lamp error Lamp fails to light. Wait a full minute and then turn 
on again.

9 cycle (0.5 sec 
On, 0.5 sec Off)

[DYNAMIC CONTRAST] error Dynamic Contrast function is not working properly. 
Contact your dealer.

Orange 1 cycle (0.5 sec 
On, 2.5 sec Off) Network conflict 

Both the built-in wired LAN and the wireless LAN can-
not be connected to the same network at the same 
time.
To use both built-in wired LAN and wireless LAN at 
the same time, connect them to different networks.

Green Re-firing the lamp (The projector is cooling 
down.)

The projector is re-firing.
Wait for a moment.

Steady light Green Standby ([NORMAL] for [STANDBY MODE]) –
Orange CONTROL PANEL LOCK is on. You have pressed cabinet button when Control 

Panel Lock is on.
CONTROL ID error Remote control ID and projector ID are not 

matched.

Lamp Indicator

Indicator Condition Projector Condition Note
Off Normal –

Blinking light Red Lamp has reached its end of life. Lamp replace-
ment message will be displayed.

Replace the lamp.

Steady light Red Lamp has been used beyond its limit. The projector 
will not turn on until the lamp is replaced.

Replace the lamp.

Green [ECO MODE] is set to [AUTO ECO], [ECO1], or 
[ECO2]

–

Over-Temperature Protection
If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the lamp 
with the STATUS indicator blinking (2-cycle On and Off.)
Should this happen, do the following:
•	 Unplug the power cord after the cooling fans stop.
•	 Move the projector to a cooler location if the room where you are presenting is particularly too warm.
•	 Clean the ventilation holes if they are clogged with dust.
•	 Wait about 60 minutes until the inside of the projector becomes cool enough.
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Common Problems & Solutions
(→ “Power/Status/Lamp Indicator” on page 127.)

Problem Check These Items

Does not turn on
or shut down

•	 Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control 
is on. (→ pages 15, 16)

•	 Ensure that the lamp cover is installed correctly. (→ page 122)
•	 Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room 

where you are presenting is particularly warm, move the projector to a cooler location.
•	 Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its 

life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 120)
•	 The lamp may fail to light. Wait a full minute and then turn on the power again.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters 

or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH 
ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple 
minutes and turn on the projector. (→ page 87)

	 If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for 
some time and then the projector will display the image. Wait for a moment.

Will turn off •	 Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 83, 90)

No picture •	 Use the COMPUTER1, the COMPUTER2, the VIDEO or the S-VIDEO button on the remote control to select your 
source (Computer, Video or S-Video). (→ page 18) If there is still no picture, press the button again.

•	 Ensure your cables are connected properly.
•	 Use menus to adjust the brightness and contrast. (→ page 76)
•	 Ensure that the lens cover is open. (→ page 7)
•	 Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 97)
•	 Enter your registered keyword if the Security function is enabled. (→ page 32)
•	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 

the power to the notebook PC.
	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 

being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver 

or power management software.
•	 See also the next page.

Picture suddenly 
becomes dark

•	 Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, 
lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 87)

Color tone or hue is 
unusual

•	 Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 82)
•	 Adjust [HUE] in [PICTURE]. (→ page 76)

Image isn’t square to 
the screen

•	 Reposition the projector to improve its angle to the screen. (→ page 19)
•	 Use the Keystone correction function to correct the trapezoid distortion. (→ page 24)

Picture is blurred •	 Adjust the focus. (→ page 23)
•	 Reposition the projector to improve its angle to the screen. (→ page 19)
•	 Ensure that the distance between the projector and screen is within the adjustment range of the lens. 

(→ page 101, 102)
•	 Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. 

Should this happen, let the projector stand until there is no condensation on the lens.

Flicker appears on 
screen

•	 Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 
feet/1600 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1600 meters and 
setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to 
[AUTO]. (→ page 87)

Image is scrolling 
vertically, horizontally 
or both

•	 Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported 
by the projector. (→ page 140)

•	 Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 78)

Remote control does 
not work

•	 Install new batteries.(→ page 11)
•	 Make sure there are no obstacles between you and the projector.
•	 Stand within 22 feet (7 m) of the projector. (→ page 11)

Indicator is lit or 
blinking

•	 See the POWER/STATUS/LAMP Indicator. (→ page 127)

Cross color in RGB 
mode

•	 Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 26)
•	 Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 77)

For more information contact your dealer.
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If there is no picture, or the picture is not displayed correctly.

•	 Power on process for the projector and the PC.

	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 
the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 
being powered up.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, 
this means there is no signal being output from the computer. (→ page 95 or go to next step)

•	 Enabling the computer’s external display.

	 Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. 
When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usu-
ally, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

•	 Non-standard signal output from the computer

	 If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed 
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each 
notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. 
Refer to your computer’s documentation for detailed information.

•	 Image displayed is incorrect when using a Macintosh

	 When using a Macintosh with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) 
according to your resolution. After setting, restart your Macintosh for the changes to take affect.

	 For setting display modes other than those supported by your Macintosh and the projector, changing the DIP switch 
on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch 
to the 13" fixed mode and then restart your Macintosh. After that, restore the DIP switches to a displayable mode 
and then restart the Macintosh again.

NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub 
15-pin connector.

•	 Mirroring on a PowerBook

*	 When using the projector with a Macintosh PowerBook, output may not be set to 1024 × 768 unless “mirroring” 
is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

•	 Folders or icons are hidden on the Macintosh screen

	 Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple 
menu and arrange icons.
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 Specifications

This section provides technical information about projector’s performance.

Model Number	 M350X/M300X/M260X/M230X/M300W/M260W
Optical

M350X M300X M260X M230X M300W M260W

LCD Panel 0.63 inch LCD with Micro Lens Array 
(Aspect Ratio 4:3)

0.63 inch LCD (Aspect Ratio 
4:3)

0.59 inch LCD with Micro Lens 
Array (Aspect Ratio 16:10)

Resolution*1 1024 × 768 pixels (XGA) 1280 × 800 pixels (WXGA)

Lens Manual zoom and focus

Zoom Ratio = 1.7
F1.7–2.1  f = 17.5–29.0 mm

Lamp 230 W AC 
(170 W in ECO1)

180 W AC 
(145 W in ECO1)
(90 W in ECO2)

180 W AC 
(145 W in 
ECO1)

230 W AC 
(170 W in 
ECO1)

180 W AC 
(145 W in 
ECO1)

Light Output*2*3 3500 lumens 3000 lumens 2600 lumens 2300 lumens 3000 lumens 2600 lumens

ECO1: 75% ECO1: 80% ECO1: 80% ECO1: 75% ECO1: 80%

ECO2: 50%

Contrast Ratio*3

(full white: full black)
2000:1

Image Size (Diagonal) 25–300 inches/0.64 m–7.6 m

Projection Distance
(Min.–Max.)

26–543 inches/0.65–13.8 m 27–573 inches/0.69–14.6 m 

Projection Angle 10.7°–11.4° (wide)/
6.5°–6.8° (tele)

10.8°–11.4° (wide)/
6.5°–6.8° (tele)

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

Electrical

M350X M300X M260X M230X M300W M260W
Inputs 2 × RGB/Component (D-Sub 15 P), 1 × HDMI Type A (HDMI® Connector) HDCP supported*4, 

1 × S-Video (DIN 4 P), 1 × Video (RCA), 1 × (L/R) RCA Audio, 2 × Stereo Mini Audio

Outputs 1 × RGB (D-Sub 15P), 1 × Stereo Mini Audio

PC Control 1 × PC Control Port (D-Sub 9P)

Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)

Wireless LAN Port  
(Optional)

IEE 802.11 b/g/n (optional Wireless LAN Unit [NP02LM Series] required)

USB Port 1 × Type A, 1 × Type B

Color Reproduction 10-bit signal processing (1.07 billion colors) (VIEWER, NETWORK: Colors, 16.7 million colors)

Compatible Signals*5 Analog: VGA/SVGA/XGA/XGA+/WXGA/WXGA+/SXGA/SXGA+/UXGA 
480i/480p/576i/576p/720p/1080i/1080p
HDMI: VGA/SVGA/XGA/WXGA/SXGA/480p/576p/720p/1080i/1080p

Video Bandwidth RGB: 80 MHz (Max.)

Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60
300 TV lines: SECAM

Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)
Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)

Sync Compatibility Separate Sync

Built-in Speaker 10W (monaural)

Power Requirement 100–240V AC, 50/60Hz

Input Current 3.4–1.5 A 2.8–1.2 A 3.4–1.5 A 2.8–1.2 A
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Power 
Consump-
tion

ECO 
MODE 
OFF 
(NOR-
MAL)

311 W 
(100-130 V)/
302 W 
(200-240 V)

248 W (100-130 V)
239 W (200-240 V)

311 W 
(100-130 V)/
302 W 
(200-240 V)

248 W 
(100-130 V)/
239 W 
(200-240 V)

ECO1 
MODE

239 W 
(100-130 V)/
236 W 
(200-240 V)

198 W (100-130 V)
193 W (200-240 V)

239 W 
(100-130 V)/
236 W 
(200-240 V)

198 W 
(100-130 V)/
193 W 
(200-240 V)

ECO2 
MODE

— 138 W (100-130 V)
136 W (200-240 V)

— — —

STANDBY 
(NOR-
MAL)

8 W (100-130 V/200-240 V)

STANDBY 
(POWER-
SAVING)

0.2 W (100-130 V)/0.4 W (200-240 V)

*4	 HDMI® (Deep Color, Lip Sync) with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a 

system for preventing illegal copying of video data sent over a Digital Visual Interface (DVI).
	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 

the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

*5	 An image with higher or lower resolution than the projector’s native resolution (M350X/M300X/M260X/M230X: 1024 × 768 / 
M300W/M260W: 1280 × 800) will be displayed with Advanced AccuBlend.

Mechanical
M350X M300X M260X M230X M300W M260W

Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 13.4" (W) × 3.9" (H) × 10.1" (D) /339 mm (W) × 99 mm (H) × 257 mm (D) 
(not including protrusions)

Weight 6.59 lbs/2.99 kg 6.39 lbs/2.9 kg 6.59 lbs/2.99 
kg

6.39 lbs/2.9 kg

Environmental 
Considerations

Operational Temperatures : 41° to 104°F (5° to 40°C), 
(ECO mode selected automatically at 95°F to 104°F/35°C to 40°C) 
20% to 80% humidity (non-condensing) 
Storage Temperatures : 14° to 122°F (-10° to 50°C), 
20% to 80% humidity (non-condensing)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class B requirements
Meets FCC Class B requirements
Meets AS/NZS CISPR.22 Class B
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)
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Model Number	 M420X/M420XV
Optical

M420X M420XV

LCD Panel 0.63 inch LCD with Micro Lens Array (Aspect Ratio 4:3)

Resolution*1 1024 × 768 pixels (XGA)

Lens Manual zoom and focus

Zoom Ratio = 1.7
F1.7–2.0  f = 19.8–23.7 mm

Lamp 265 W AC 
(195 W in ECO1)

Light Output*2*3 4200 lumens 

ECO1: 75%

Contrast Ratio*3

(full white: full black)
2000:1

Image Size (Diagonal) 25–300 inches/0.64 m–7.6 m

Projection Distance
(Min.–Max.)

25–542 inches/0.64–13.8 m

Projection Angle 10.7°–11.6° (wide)/
6.5°–6.8° (tele)

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

Electrical

M420X M420XV
Inputs 2 × RGB/Component (D-Sub 15 P), 1 × HDMI Type 

A (HDMI® Connector) HDCP supported*4, 
1 × S-Video (DIN 4 P), 1 × Video (RCA), 1 × (L/R) 
RCA Audio, 2 × Stereo Mini Audio

2 × RGB/Component (D-Sub 15 P), 1 × HDMI Type 
A (HDMI® Connector) HDCP supported*4, 
1 × S-Video (DIN 4 P), 1 × Video (RCA)

Outputs 1 × RGB (D-Sub 15P), 1 × Stereo Mini Audio 1 × RGB (D-Sub 15P)

PC Control 1 × PC Control Port (D-Sub 9P)

Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)

Wireless LAN Port  
(Optional)

IEE 802.11 b/g/n (optional Wireless LAN Unit [NP02LM Series] required)

USB Port 1 × Type A, 1 × Type B

Color Reproduction 10-bit signal processing (1.07 billion colors) (VIEWER, NETWORK: Colors, 16.7 million colors)

Compatible Signals*5 Analog: VGA/SVGA/XGA/XGA+/WXGA/WXGA+/SXGA/SXGA+/UXGA 
480i/480p/576i/576p/720p/1080i/1080p
HDMI: VGA/SVGA/XGA/WXGA/SXGA/480p/576p/720p/1080i/1080p

Video Bandwidth RGB: 80 MHz (Max.)

Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60
300 TV lines: SECAM

Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)
Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)

Sync Compatibility Separate Sync

Built-in Speaker 10W (monaural) No speaker

Power Requirement 100–240V AC, 50/60Hz

Input Current 3.9–1.7 A
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Power 
Consump-
tion

ECO 
MODE 
OFF 
(NOR-
MAL)

358 W (100-130 V)
343 W (200-240V)

ECO1 
MODE

271 W (100-130 V)
264 W (200-240V)

STANDBY 
(NOR-
MAL)

8 W (100-130 V/200-240 V)

STANDBY 
(POWER-
SAVING)

0.2 W (100-130 V)/0.4 W (200-240 V)

*4	 HDMI® (Deep Color, Lip Sync) with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a 

system for preventing illegal copying of video data sent over a Digital Visual Interface (DVI).
	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 

the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

*5	 An image with higher or lower resolution than the projector’s native resolution (1024 × 768) will be displayed with Advanced 
AccuBlend.

Mechanical
M420X M420XV

Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 15.7" (W) × 4.5" (H) × 11.1" (D) /398 mm (W) × 115 mm (H) × 282 mm (D) 
(not including protrusions)

Weight 7.9 lbs/3.6 kg 7.7 lbs/3.5 kg

Environmental 
Considerations

Operational Temperatures : 41° to 104°F (5° to 40°C), 
(ECO mode selected automatically at 95°F to 104°F/35°C to 40°C) 
20% to 80% humidity (non-condensing) 
Storage Temperatures : 14° to 122°F (-10° to 50°C), 
20% to 80% humidity (non-condensing)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class B requirements
Meets FCC Class B requirements
Meets AS/NZS CISPR.22 Class B
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)
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Model Number	 M350XS/M300XS/M260XS/M300WS/M260WS
Optical

M350XS M300XS M260XS M300WS M260WS

LCD Panel 0.63 inch LCD with Micro Lens Array (Aspect Ratio 4:3) 0.59 inch LCD with Micro Lens Array 
(Aspect Ratio 16:10)

Resolution*1 1024 × 768 pixels (XGA) 1280 × 800 pixels (WXGA)

Lens Digital zoom and manual focus

Digital Zoom Ratio = 1.2
F2.0  f = 6.4 mm

Lamp 265 W AC 
(195 W in ECO1)

230 W AC 
(170 W in ECO1)

180 W AC 
(145 W in ECO1)
(90 W in ECO2)

265 W AC 
(195 W in ECO1)

230 W AC 
(170 W in ECO1)

Light Output*2*3 3500 lumens 3000 lumens 2600 lumens 3000 lumens 2600 lumens

ECO1: 75% ECO1: 75% ECO1: 80% ECO1: 75% ECO1: 75%

ECO2: 50%

Contrast Ratio*3

(full white: full black)
2000:1

Image Size (Diagonal) 60–110 inches/1.52 m–2.79 m 56.2–104 inches/1.47 m–2.64 m

Projection Distance
(Min.–Max.)

23–43 inches/0.57–11.0 m 22–43 inches/0.57–11.0 m 

Projection Angle 37.3°–38.6°

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

Electrical

M350XS M300XS M260XS M300WS M260WS
Inputs 2 × RGB/Component (D-Sub 15 P), 1 × HDMI Type A (HDMI® Connector) HDCP supported*4, 

1 × S-Video (DIN 4 P), 1 × Video (RCA), 1 × (L/R) RCA Audio, 2 × Stereo Mini Audio

Outputs 1 × RGB (D-Sub 15P), 1 × Stereo Mini Audio

PC Control 1 × PC Control Port (D-Sub 9P)

Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)

Wireless LAN Port  
(Optional)

IEE 802.11 b/g/n (optional Wireless LAN Unit [NP02LM Series] required)

USB Port 1 × Type A, 1 × Type B

Color Reproduction 10-bit signal processing (1.07 billion colors) (VIEWER, NETWORK: Colors, 16.7 million colors)

Compatible Signals*5 Analog: VGA/SVGA/XGA/XGA+/WXGA/WXGA+/SXGA/SXGA+/UXGA 
480i/480p/576i/576p/720p/1080i/1080p
HDMI: VGA/SVGA/XGA/WXGA/SXGA/480p/576p/720p/1080i/1080p

Video Bandwidth RGB: 80 MHz (Max.)

Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60
300 TV lines: SECAM

Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)
Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)

Sync Compatibility Separate Sync

Built-in Speaker 10W (monaural)

Power Requirement 100–240V AC, 50/60Hz

Input Current 3.9–1.7 A 3.4–1.5 A 2.8–1.2 A 3.9–1.7 A 3.4–1.5 A
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Power 
Consump-
tion

ECO 
MODE 
OFF 
(NOR-
MAL)

358 W (100-130 V)
343 W (200-240 V)

311 W (100-130 V)
302 W (200-240 V)

248 W (100-130 V)
239 W (200-240 V)

358 W (100-130 V)
343 W (200-240 V)

311 W (100-130 V)
302 W (200-240 V)

ECO1 
MODE

271 W (100-130 V)
264 W (200-240 V)

239 W (100-130 V)
236 W (200-240 V)

198 W (100-130 V)
193 W (200-240 V)

271 W (100-130 V)
264 W (200-240 V)

239 W (100-130 V)
236 W (200-240 V)

ECO2 
MODE

— — 138 W (100-130 V)
136 W (200-240 V)

— —

STANDBY 
(NOR-
MAL)

8 W (100-130 V/200-240 V)

STANDBY 
(POWER-
SAVING)

0.2 W (100-130 V)/0.4 W (200-240 V)

*4	 HDMI® (Deep Color, Lip Sync) with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a 

system for preventing illegal copying of video data sent over a Digital Visual Interface (DVI).
	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 

the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

*5	 An image with higher or lower resolution than the projector’s native resolution (M350XS/M300XS/M260XS: 1024 × 768 and 
M300WS/M260WS: 1280 × 800) will be displayed with Advanced AccuBlend.

Mechanical
M350XS M300XS M260XS M300WS M260WS

Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 15.7" (W) × 12.2" (H) × 5.5" (D) /398 mm (W) × 140 mm (H) × 309 mm (D) 
(not including protrusions)

Weight 8.8 lbs/4.0 kg

Environmental 
Considerations

Operational Temperatures : 41° to 104°F (5° to 40°C), 
(ECO mode selected automatically at 95°F to 104°F/35°C to 40°C) 
20% to 80% humidity (non-condensing) 
Storage Temperatures : 14° to 122°F (-10° to 50°C), 
20% to 80% humidity (non-condensing)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class B requirements
Meets FCC Class B requirements
Meets AS/NZS CISPR.22 Class B
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)

For additional information visit:
US : http://www.necdisplay.com/
Europe : http://www.nec-display-solutions.com/
Global : http://www.nec-display.com/global/index.html
For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.

http://www.necdisplay.com/
http://www.nec-display-solutions.com/
http://www.nec-display.com/global/index.html
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[M420X/M420XV]
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[M350XS/M300XS/M260XS/M300WS/M260WS]
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Mini D-Sub 15 Pin Connector
4 Pin Assignments of D-Sub COMPUTER Input Connector

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

51 42 3
10

11 12 13 14 15
6 97 8

COMPUTER 1 IN
NOTE: Pin Nos. 12 and 15 are required for DDC/CI.
 

	Pin No. 	 RGB Signal (Analog)	 YCbCr Signal

	 1	 Red	 Cr
	 2	 Green or Sync on Green	 Y
	 3	 Blue	 Cb
	 4	 Ground
	 5	 Ground
	 6	 Red Ground	 Cr Ground
	 7	 Green Ground	 Y Ground
	 8	 Blue Ground	 Cb Ground
	 9	 No Connection
	 10	 Sync Signal Ground
	 11	 No Connection	
	 12	 Bi-directional DATA (SDA)
	 13	 Horizontal Sync or Composite Sync
	 14	 Vertical Sync
	 15	 Data Clock
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5 Compatible Input Signal List

Analog RGB

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60/72/75/85/
iMac

SVGA 800 × 600 4:3 56/60/72/75/85/
iMac

XGA 1024 × 768 *1 4:3 60/70/75/85/
iMac

XGA+ 1152 × 864 4:3 60/70/75/85
WXGA 1280 × 768 *2 15:9 60

1280 × 800 *2 16:10 60
1360 × 768 *3 16:9 60
1366 × 768 *3 16:9 60

Quad-VGA 1280 × 960 4:3 60/75
SXGA 1280 × 1024 5:4 60/75
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 *3 16:9 60
UXGA 1600 × 1200 4:3 60
WSXGA+ 1680 × 1050 16:10 60
HD 1280 × 720 16:9 60
Full HD 1920 × 1080 16:9 60
MAC 13" 640 × 480 4:3 67
MAC 16" 832 × 624 4:3 75
MAC 19" 1024 × 768 4:3 75
MAC 21" 1152 × 870 4:3 75
MAC 23" 1280 × 1024 5:4 65

Component

Signal Format Aspect Ratio
Refresh Rate

( Hz )
HDTV (1080p) 1920 × 1080 16:9 60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
SDTV (480i) 720 × 480 4:3/16:9 60
SDTV (576i) 720 × 576 4:3/16:9 50

Composite Video/S-Video

Signal Aspect Ratio
Refresh Rate

( Hz )
NTSC 4:3 60
PAL 4:3 50
PAL60 4:3 60
SECAM 4:3 50

*1	Native resolution on XGA model (M350X/M300X/M260X/M230X/
M420X/M420XV/M350XS/M300XS/M260XS) 

*2	Native resolution on WXGA model (M300W/M260W/M300WS/
M260WS)

*3	The projector may fail to display these signals correctly when [AUTO] 
is selected for [ASPECT RATIO] in the on-screen menu.

	 The factory default is [AUTO] for [ASPECT RATIO]. To display these 
signals, select [16:9] for [ASPECT RATIO].

NOTE:
•	 An image with higher or lower resolution than the projector’s native resolution (M350X/M300X/M260X/M230X/M420X/M420XV/

M350XS/M300XS/M260XS: 1024 × 768 / M300W/M260W/M300WS/M260WS: 1280 × 800) will be displayed with Advanced 
AccuBlend.

•	 Sync on Green and Composite sync signals are not supported.
•	 Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh 

rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.

HDMI

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60
SVGA 800 × 600 4:3 60
XGA 1024 × 768 *1 4:3 60
WXGA 1280 × 768 *2 15:9 60

1280 × 800 *2 16:10 60
1366 × 768 16:9 60

Quad-VGA 1280 × 960 4:3 60
SXGA 1280 × 1024 5:4 60
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 16:9 60
WSXGA+ 1680 × 1050 16:10 60
HDTV (1080p) 1920 × 1080 16:9 50/60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
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NOTE:
*	 The “SOUND MUTE OFF” and “SOUND MUTE ON” functions are not available on M420XV.

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection
Communication Protocol

Baud rate	�����������������������������������������38400 bps
Data length	��������������������������������������8 bits
Parity	�����������������������������������������������No parity
Stop bit	��������������������������������������������One bit
X on/off	��������������������������������������������None
Communications procedure..............Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (D-SUB 9P)

6 PC Control Codes and Cable Connection
PC Control Codes

Function	 Code Data

POWER ON	 02H	 00H	 00H	 00H	 00H	 02H

POWER OFF	 02H	 01H	 00H	 00H	 00H	 03H

INPUT SELECT COMPUTER 1	 02H	 03H	 00H	 00H	 02H	 01H	 01H	 09H

INPUT SELECT COMPUTER 2	 02H	 03H	 00H	 00H	 02H	 01H	 02H	 0AH

INPUT SELECT HDMI	 02H	 03H	 00H	 00H	 02H	 01H	 1AH	 22H

INPUT SELECT VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 06H	 0EH

INPUT SELECT S-VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 0BH	 13H

INPUT SELECT VIEWER	 02H	 03H	 00H	 00H	 02H	 01H	 1FH	 27H

INPUT SELECT NETWORK	 02H	 03H	 00H	 00H	 02H	 01H	 20H	 28H

INPUT SELECT USB DISPLAY	 02H	 03H	 00H	 00H	 02H	 01H	 22H	 2AH

PICTURE MUTE ON	 02H	 10H	 00H	 00H	 00H	 12H

PICTURE MUTE OFF	 02H	 11H	 00H	 00H	 00H	 13H

SOUND MUTE ON*	 02H	 12H	 00H	 00H	 00H	 14H

SOUND MUTE OFF*	 02H	 13H	 00H	 00H	 00H	 15H

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.

1 52 43

6 7 98

To GND of PC
To RxD of PC
To TxD of PC

To RTS of PC

To CTS of PC
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No image is displayed from your PC or video equipment to the 
projector.

Still no image even though you connect the projector to the PC 
first, then start the PC.
Enabling your notebook PC’s signal output to the projector.
•	 A combination of function keys will enable/disable the exter-

nal display. Usually, the combination of the “Fn” key along 
with one of the 12 function keys turns the external display 
on or off. 

No image (blue or black background, no display).
Still no image even though you press the AUTO ADJUST 
button.
Still no image even though you carry out [RESET] in the 
projector’s menu.
Signal cable’s plug is fully inserted into the input connector
A message appears on the screen.
( _____________________________________________ )
The source connected to the projector is active and available.
Still no image even though you adjust the brightness and/or 
the contrast.
Input source’s resolution and frequency are supported by the 
projector.

7 Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by 
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem 
more efficiently.
* Print this page and the next page for your check.

Frequency of occurrence   always    sometimes (How often?_____________________)     other (__________________)
Power

No power (POWER indicator does not light blue)  See also “Status 
Indicator (STATUS)”.

Power cord’s plug is fully inserted into the wall outlet.
Main power switch is pressed to the ON position.
Lamp cover is installed correctly .
Lamp Hours Used (lamp operation hours) was cleared after 
lamp replacement.
No power even though you press and hold the POWER button 
for 1 second.

Shut down during operation.
Power cord’s plug is fully inserted into the wall outlet.
Lamp cover is installed correctly .
[AUTO POWER OFF] is turned off (only models with the [AUTO 
POWER OFF] function).
[OFF TIMER] is turned off (only models with the [OFF TIMER] 
function).

Video and Audio

Image is too dark.
Remains unchanged even though you adjust the brightness 
and/or the contrast.

Image is distorted.
Image appears to be trapezoidal (unchanged even though you 
carry out the [KEYSTONE] adjustment).

Parts of the image are lost.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.

Image is shifted in the vertical or horizontal direction.
Horizontal and vertical positions are correctly adjusted on a 
computer signal.
Input source’s resolution and frequency are supported by the 
projector.
Some pixels are lost.

Image is flickering.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.
Image shows flickering or color drift on a computer signal.
Still unchanged even though you change [FAN MODE] from 
[HIGH ALTITUDE] to [AUTO].

Image appears blurry or out of focus.
Still unchanged even though you checked the signal’s resolution 
on PC and changed it to projector’s native resolution.
Still unchanged even though you adjusted the focus.

No sound.
Audio cable is correctly connected to the audio input of the 
projector.
Still unchanged even though you adjusted the volume level.
AUDIO OUT is connected to your audio equipment (only models 
with the AUDIO OUT connector).

Other
Remote control does not work.

No obstacles between the sensor of the projector and the 
remote control.
Projector is placed near a fluorescent light that can disturb the 
infrared remote controls.
Batteries are new and are not reversed in installation. 

Buttons on the projector cabinet do not work (only models with the 
[CONTROL PANEL LOCK] function)

[CONTROL PANEL LOCK] is not turned on or is disabled in 
the menu.
Still unchanged even though you press and hold the EXIT button 
for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Eco Mode:	  OFF   AUTO ECO
	  ECO1   ECO2
Information on input signal:

Horizontal synch frequency	 [          ] kHz
Vertical synch frequency	 [          ] Hz
Synch polarity	 H  (+)   (−)
	 V  (+)   (−)
Synch type	  Separate   Composite

	  Sync on Green
STATUS Indicator:

Steady light	  Orange   Green
Flashing light	 [          ] cycles

Remote control model number:

Signal cable

NEC standard or other manufacturer’s cable?
Model number:                        Length:              inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Projector PC

DVD player

Installation environment

Screen size:			   inch
Screen type:	  White matte    Beads   Polarization
	  Wide angle	   High contrast
 Throw distance:		  feet/inch/m
 Orientation:	  Ceiling mount    Desktop
Power outlet connection:

	 Connected directly to wall outlet
	 Connected to power cord extender or other (the 

number of connected equipment______________)
	 Connected to a power cord reel or other (the number 

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC  / Desktop 

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:



144

8. Appendix

8 TravelCare Guide
TravelCare - a service for international travelers
This product is eligible for “TravelCare”, NEC’s unique international warranty and repair service.
For more information on TravelCare service, visit our website (in English only).
http://www.nec-display.com/dl/en/pj_support/travel_care.html

9 TCO Certification
Some models in this product family are TCO certified. All TCO certified models have the TCO mark on the marking 
plate (on the bottom of the product). To see a list of our TCO certified projectors and their TCO Certification (in English 
only), visit our website at http://www.nec-display.com/ap/en_projector/tco/index.html
The TCO certification, designed by TCO Development, is an international environmental and ergonomics standard 
for IT equipment. 
In some cases we may post a list of TCO certified models on our website before the TCO mark is placed on the prod-
uct. This difference in timing is related to the date certification is received compared with the projectors manufacturing 
date.

http://www.nec-display.com/dl/en/pj_support/travel_care.html
http://www.nec-display.com/ap/en_projector/tco/index.html
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